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I.-GENERAL.

This manual will guide them through the operation of the program. It is obvious that all the
skills he holds, can be included in a manual. Daily management is the best way to obtain
optimal yields.

II .- INTRODUCTION.

IdemHotel is designed to handle quick, efficient and easy reservations, services, billing, ... .
In short, the daily management of a hotel.
For this is a series of files that store all the information necessary to carry out such
management. These are:

- COMPANY in question, which in this case is the Hotel.
- CLIENTS, AGENCIES.
- PARTS OF PASSENGERS AND RECORD BOOK.
- Services, which provides the hotel.
- Price of SERVICES.
- ROOMS consisting of the Hotel.
- ROOM RATES, according to the different seasons of the year.
- TYPE OF ROOM.
- WAITING LISTS.
- BILLS.
- ...
Besides this, IdemHotel consists of a section BOOKING / RECORDS where he recorded all
reservations are made.

When we want to check a room IdemHotel will show all services to be performed in each
room, but we can forget any.

IdemHotel automatically selects both the presentation format of numbers, such as the
presentation format of the date, depending on the option selected in the operating system. For
example Use the comma [,] as a decimal point [.] As a thousands separator.

It then explains in detail the operation of this IdemHotel.

III .- GLOSSARY.

- Country: specific part of a chip that identifies a part of it. For example, the name of a client.
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- File: information block. For example, all data from a client.
- File: A set of chips. For example, the customer file, which contains data on all clients,
discharged from the database.
- Database: Management where you put all the information we create and we use in the
program (Data).
- Give the database information we put into the program when you "click" on the REC button
of various maintenance.
- The program that goes through the different menus. For example by "clicking" Clients in the
File menu is accessed by keeping customers.

IV .- BUTTONS

Throughout the entire application is a series of buttons that appear whenever they have the
same meaning. These buttons are:

- Calculator
Button by which you can access the calculator that provides the Application. You can access
it from any point of management.

This is a calculator that can perform basic operations in any currency, including Euros, giving
us the change automatically to euros.

- Cancel
This button allows the cancellation of restoring data from a previous tab. This option is useful
in cases where data are changed in a particular form and then want to leave as it was.

Importantly, all this work if not previously pressed the Record button, but the card data will
have been saved in the file and modify again will have to rewrite.

This key also exit the screen and is usually associated're pressing the "escape."

- Record can record the data in a tab in the corresponding file.

- First records show, the first data file record.

- Late Registration data shows the last log file.

- Previous record shows the data from the previous record.

- Record data below shows the next record.

- Delete Delete the tab that is displayed on screen.
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- Print Prints the data, reports, etc ...

- Manual If you have Internet connection will open the manual by clicking the Manual button.
Selection may view as pdf (requires Adobe acrobat reader) or through your Internet browser.

- Making Change User "click" on the field with the name of the connected user can switch
users without leaving the program.

V - ACCESS TO IdemHotel.

1.-ACCESS FOR THE FIRST TIME.

Doing "double click" on the icon IdemHotel, the first time we come, we will have the option
to create a new database, or otherwise, you can open an existing database, as explained later
in Database paragraph.

First visualize the display window of the program, which only appear in the case that we have
not entered the license in the program. To enter the license to do "click" on the button to enter
the codes LICENSE No. Product Serial, License Code, to be supplied IdemSoft, SL and to
"click" on the REC button, which will disappear when the limitation by date of completion.

In the case of a database of the Demo to test the program and not wanting to enter the license
to "click" right away and put in the User Access window Demo and Password Demo.

When creating a new database IdemHotel asked to enter User Name and Password, and the
name of the company. The company name must be the same as that of the License.

Since version 2004.5 IdemHotel is multilingual (Català, Deutsch, Inglés, Spanish, French,
Valencia.).
This allows two options:
a) Select the user interface language with which we work.
b) H print in most cases we can select the language you want to print it.

The configuration of a PC monitor to properly view IdemHotel screens must be at least 800
by 600 pixels. To change this setting first will "click" with the right mouse button on the
bottom of the monitor screen, select the Properties window that we have envisioned and to
"click" on the label of Configuration Properties window screen. Already here, we select the
configuration shown from where it says screen area.

2 .- ACCESS IdemHotel

The first screen is the display window of the program, while still not entered the License. To
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do "click" on the Continue button to access the User Selection window, which requests the
user name and password.

Once this fantastic License this window will appear directly without previewing the display
window above. If error is introduced by another key that is not correct, the management will
not allow the man entry for that user.

If you want to change the User Password, press the button (F3-KEY CHANGE).

IdemHotel we are asked to enter the new password and to verify that we do not repeat a
mistake entering the key.
When you "click" on the SAVE button IdemHotel F2-key saves the new user selected.

vi .- DATABASE

1.-WINDOWS

The first time you open the program by "double click" on the icon that runs the same, we can
create a database or open the Database Demo version.

To create the database, to press the New button (New). Will display a window with the name
of IdemHotel, which may change. Once we are sure of the name, we will "click" on Save, in
order to create the new database. Management Database saved with the extension (.4 dd) This
process can take several minutes.

Selected database, run the program from now on automatically with the selected Database.

If we change the database, immediately after doing "double click" on the icon to run the
program, keep pressing the "Alt." We create a new database as explained above.

2.-MACINTOSH

The first time you open the program by "double click" on the icon that runs the same, we can
create a database or open the Database Demo version.

To create a new database will "click" on the New button (New). A window with the name of
the management, which may change. Once we are sure of the name, we will "click" on Save,
in order to create the new database. This process can take several minutes.

Selected database, run the program from now on automatically with the selected Database.
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If we change the database, immediately after doing "double click" on the icon to run the
program, keep pressing the "Alt." We create a new database as explained above.

VII .- GENERAL MENU

As can be seen on the next screen in the General Menu IdemHotel, see the following buttons:
File, Booking / Records / Billing, Text / Mailing, List, and Utilities.

Also, by "clicking" this button can display and print (if you have Internet access) the manual
as described in the section buttons.
From here you can connect to our website or send an e_mail by "click" on the corresponding
buttons.

Using "click" on the field with the name of the connected user can switch users by entering
the name and password of the user you want to connect, without having to exit the program
and re-enter.

Upon entering we also show a floating menu, which is accessible from the entire program:

From here you can access:
 - Key Dates. From here you can color with a red background the dates on the grid we want to
highlight.

 - It allows us to access the calendar / alarm

 - Calculator

 - Calendar, monthly or quarterly

 - Search for telephone numbers within IdemHOTEL

 - Display the reservation grid

 - Maintenance Other contacts

- Direct access to Mailing

IdemHOTEL v.2012.0 Page 11 of 81



 - Direct access to cash count

1 .- FILES.

From this menu you can access the display window of the program, user manual and switch
connected in the same way as in the General Menu.

Here they keep all the information regarding the Company's customers the same, the types of
clients, services provided by the Hotel, the prices of the Services, the rooms you have and the
rates of each of them, according to season, room type and room use, different types of rooms,
Agencies, Users and diet ... .

Here's how each one of the files mentioned above.

1.1 .- COMPANY.

This tab stores all information relating to the Company of the question, in this case, the Hotel
to be used IdemHotel.

The company card is divided into different sections:

We will have each of them by clicking on the appropriate tab.

a) Overview of the Hotel. This information is collected basic data from the company: Name,
Address, ...

b) Billing. Billing data on: Number following applicable tax, print format.

c) Currency of work. We can use any currency, and define in this section.

d) Accounting. Collect all accounts required to export invoices to an accounting program
(IdemCONTA)

e) e_mail. Here we will introduce the e-mail account of the company as well as how to
connect through SMTP.

f) Police / Guardia Civil / Autonomous Police. It contains all the information needed to
comply with its obligations under the law July 11, 2003.

g) power unit. This section is reserved for connections to telephone exchanges. Available as
part module, after investigation and adaptation in each case.

1.1.1 .- Create the Company.
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When we create a new database, IdemHotel will display a screen on which the hotel will
introduce. This data can enter when creating the database or when we come by "click" on the
File menu button COMPANY.

- General data, such as Name, City, Address, State, Tax ID, Country, Postal Code, Phone and
Fax. In the case of tax identification will have to indicate the title (NIF, CIF) and the number
in the appropriate boxes.
Below the name are two fields, one to indicate the type of hotel and another to indicate the
category Hotel, for printing the input sheet and the Bills Traveler indicate the type and
category of hotel.

- Anagram, or you can set, if desired, an anagram of the Company, by importing the file
where it is stored.
When you "click" the button IdemHotel removed from the anagram.

- Signature; You can save the firm together with the seal, then you can use it to send proof of
reservation ..
When you "click" the button IdemHotel removed from the firm.

- Web. In this field indicates the name of the hotel website for you to print on cards and
traveler's admission on invoices.

- Counter: Party Flyer. This field is where it is stated the actual number of travelers, which is
printed on both the Admission Form Traveler as the party of travelers. The difference is
simply the format in which they are printed.

Using "click" on the "tab" Police / Guardia Civil:

- In this section we introduce all the necessary information to comply with its obligations
under the law July 11, 2003.

In Name: The trade name, which is known to the establishment, with a maximum of 40
characters.
Sex: indicate the title and key to the sexes.
Web Shipping DGGCivil / DGP / Moss / Ertzaintza: indicate the corresponding Web.

If you have modified these fields and want to go back to standard shipping to the DGGCivil /
DGP / Moss / Ertzaintza only have to click on the "Data according DGGCivil / DGP / Moss /
Ertzaintza" and naturally Record.
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IdemHotel easy to send us the parts with two systems (the latter only valid at the moment, for
Guardia Civil)

1) In Schedule daily delivery of parts: We can set an alarm for every day when we tell you,
we remember to send the report.

2) In Automatic transmission, every minute, displays minutes and IdemHotel if the parties
remains to be sent, it will send, without user intervention. Only valid for Guardia Civil.

In DGGCivil Code / DGP / Moss / Ertzaintza: This code is assigned by the DGGCivil / DGP
/ Moss and it is imperative to send the Internet for DGGCivil / DGP / Mossos passengers
daily sheets.

Key DGGCivil / DGP / Moss / Ertzaintza: This key is assigned by the DGGCivil / DGP /
Moss / Ertzaintza and it is imperative to send the cards for Internet travelers daily. .

To obtain this code and password must be accredited by the police station / civil guard their
area. They must fill out the form which can be obtained on our Web site:

http://www.idemsoft.com/idemhotel/idemhotelpar.php
- Format. Pdf (Adobe Acrobat Reader)
- Format. Doc (Microsoft Word)
For the Autonomous / Ertzaintza should contact the nearest unit.

In Next File No. P DGGCivil / DGP / Moss / Moss / Ertzaintza: This counter is not we
change it normally. It is used to send the file to DGGCivil / DGP and is a value from 0 to
999. When you get to 999 in 001 starts automatically.
In File No. Posted Last DGGCivil / DGP / Moss / Moss / Ertzaintza: This counter is not we
change it normally. Control is used to send the file to DGGCivil / DGP and is a value from 0
to 999. When you get to 999 in 000 starts automatically.

Reports Archive shipping In DGGCivil / DGP / Moss / Moss / Ertzaintza: Here you indicate
where you want to save their reports. In this way we can revise or delete them. The files are
named according to a defined format, so that the name must match the assigned user and the
extension with the serial number.
So if we assign the number of users: 280032JKPA
The files will be sent:
280032JKPA.001
280032JKPA.002
...
We can select Manual Introduction Part of Traveler number, so we asked the number of party
every time we need to create one.
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If you select Copy Control Security Backup 4D, each time we leave IdemHotel, informs us
when was the last copy and gives us the ability to perform the backup.
This option can make whatever "tab is selected, it is common to all three parts of the sheet of
the Company.

Choice Linen change (Days) lets you specify overnight every few days you want to change
the sheets. This option is linked to the daily list of Head Service, which will show if there is
to be changed.

Using "click" on the "tab" E_Mail:

- E_Mail. This field indicates the email address of the hotel. This will serve both to print in
the traveler's admission records and bills the email address of the hotel, and for the
forwarding of the traveler to DGP .
If you have the Mailing module. In the "Text message down" you can put the message you
want displayed in the footer of the emails. Is designed for you to comply with the LPD and
indicate how to tell you if do not wish to receive advertising emails from you

- SMTP. In this field indicates the outgoing mail server with which we work. Likewise, in the
case that requires authentication, checking this option and put the username and password.

Using "click" on the "tab" Show;

- Funds. We can choose between different funds to IdemHotel.
- Grid. We choose the grid with which we prefer to work: Monthly, Weekly, Fortnightly
enlarged, Weekly, Weekly enlarged. Naturally at any time can change from one to another, as
best suits our needs.

Using "click" on the "tab" Other:

- Text Courtesy. There is a section where you can enter free text and then inserting (with a
click) on the bills you want to avoid having to type it every time.

- Text Intake Sheet. There is a section where you enter text for Admission Sheet, as required.
This is automatically included when you print the sheet.
Ahem.: Limit time: 12:00 Hrs.

- Days notice birthday. Indicate a time limit in days to let us know IdemHotel the customer's
birthday if your birthday is within the specified period before or after the date on the
reservation or the current date, whichever is less difference exists .

Using "click" on the "tab" Billing we provide the following information:
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- Series of bills. Put billing, Series / Prefix, to assign each invoice number series / prefix
indicated. We can not indicate the letter "P" as the Series / Prefix to use for the Proforma
invoice.
Using "click" the icon is next to the Series / Prefix above, display a window where we can
clear all the bills that contain the Series / Prefix that we selected in the above, deleting these
bills and all services are allocated in such bills.

- Number of Bill next to the automatic assignment of the invoice number.

- Number following proforma. When you proforma invoice number that corresponds to
indicate the counter preceded by the letter "P".

- Tax, indicate the title of the tax (VAT) and percentage (%) in the appropriate boxes and by
country, selected to appear automatically in the appropriate maintenance (calculating the price
of the rooms).

- Print Anagram and Company Details. Checking this option, print invoices and print the logo
data we have assigned to the Business tab in the "General tab.

- Print your business name on invoices. Checking this option displays a field to indicate the
trade name of the company (name of hotel), which will print on Invoices IdemHotel.

- Size of paper invoice. If you select the option 210 x 297 mm to print invoices from the
corresponding chip stocks, IdemHotel bills printed in the appropriate size (folio, A4).
If you select the option 147 x 210 mm printed bills in the corresponding size (half size of an
A4 sheet).
Also in this last option IdemHotel gives us another option, Pre-printed paper that can print to
mark the bills with just the information itself, not the hotel, the logo or the boxes, so we can
use pre-paper printed.

- Select a piece of work according to the country where we are, enter the appropriate currency
symbol and the number of decimal places you want to use when calculating the rounding of
currency.
Only if we select as the Euro currency will allow us to choose whether we want to see prices
in Euros and Pesetas on screens Reservations, Booking Form, Prices of rooms, services and
bills, choosing the prices will not only in Euro and selecting the Yes (it will be in Euros and
Pesetas).

Using "click" on the "tab" TPVBar in case you have hired TPVBar module allows you to
specify a range of options including:
- If you want to print the logo on the ticket.
- Text courtesy
- Key lock. This key is used to lock / unlock the TPV quickly. To get away from it without
danger of their handling, open drawer, ...
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Using "click" on the "tab" will mark the option Accounting Accounting Link (IdemConta) if
you want to export invoices IdemHotel believe in an outside file to import it from IdemHotel
IdemConta and thus automatically account for these invoices (See section 5.6 .- Export
invoices to accounting).

When you check the Link option will force Accounting IdemHotel assign a ledger account to
Clients, Agencies and Services for proper accounting.

When you check this option indicate:
1 .- Account Sales. Account keeping used by default to check the room and the services
assigned to the room.
This book has the file can be changed from the Services (see section 1.3 .- Service)
2 .- It has output VAT. Accountant Account for the tax (VAT).

After entering the information, all data just mentioned, should be recorded, press the Record
button, so they can be stored in the database.

1.1.2 .- Edit company data

To change the Hotel in question, once recorded, you just have to enter the screen where all
the data, as mentioned above and proceed to its amendment.
As before, we must save the changes to be made, but IdemHotel not keep making "click" on
the REC button.

1.2 .- CUSTOMERS.

This file stores all information relating to Customers of that Hotel. To access it, we must
press the client, from the File Maintenance in the General Menu.

Upon entering the maintenance IdemHotel ask if you want to see all clients discharged so far.
Depending on the response will show a listing or other:
- If the answer is YES, a list with all clients stored in the database and sorted alphabetically.
- Conversely, if the answer is NO, you must choose your search criteria so that only displayed
the list with customers want.

1.2.1 .- Create a new customer.

Whenever you enter a new customer in the hotel, we will create a page with information
about it to the reserves of the rooms and to check and print the information about the traveler
with its data.
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To register a new client, will press the button NEW. In the information about the client
introduce new information in different "tabs", as that information is.

Using "click" on the "tab" Private Data will fill the client's personal data, your usual payment
and the rate will be allotted on the reserve and in services.

- Personal Information.
Name, CIF, Customer Type, Nationality, Address, City, State, Country, Two Telephones,
Postal Code, E_Mail.

Customer Type select it by clicking on the field and re-click on the name that interests us
from the displayed list.

Next to the CIF field, as we have indicated Spain or Spain in the Country field, the button is
active (NIF). Also, if you have questions about acceptable document type, you can click the
button information which will show the instructions for the proper selection of the type of
travel document.
When you "click" that button IdemHotel reports which is the letter that corresponds to and
gives us the option to automatically enter the correct letter in the Tax field.

- Assigned Room rate.
In the field of Assigned Room rate the customer card will assign the client rate. This fee will
automatically assign IdemHotel the tab of the reserve when assigning the customer to the
reservation unless the reservation assigned to an agency and it has another different rate, in
which case the corresponding IdemHotel assigned to the Agency.
Anyway you can select any rate of interest as we explained in paragraph Reserve.
If we want to de-select the rate and let the customer card with no rate assigned will "click" on
the button.

- Rate assignment.
In the field Apportioned Rates Customer tab assign the rate of the customer. This fee will
automatically assign IdemHotel the tab for services when the client is assigned to the reserve.
Anyway you can select any rate of interest as we explained in section Services.
If we want to de-select the rate and let the customer card with no assigned service fee will
"click" on the button.

- Language.
The language preferred by the client to print.

- Payment.
In the Payment field assign the Form that the customer will pay the room. This payment will
be assigned IdemHotel in the reservation form when assigning the customer to the reservation.
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Anyway you can select when booking any form of payment as described in paragraph
Reserves.
If we want to de-select the Payment tab and leave the client without any form of payment
assigned will "click" on the button.

- Head of Service.
Add a new Service Manager tab, which allows you to specify client feedback to the daily list
of Chief Service ..

- Moroso.
If you check Moroso, IdemHotel put a label on the customer card indicating that a customer is
Moroso.
When selected for reservations and invoices, IdemHotel also remind us that a customer is
Moroso.
 
-------------------------------------------------- -----------------------------
Only for Spain:

- Region statistics.
This reflects the place of residence, according to those in the INE statistics . Allowing
statistical calculation automatically (if you have the module purchased)

- Nationality.
IdemHotel comes with the list of countries, as required by the DGP, so that should not be
changed, if you will be subject to the law of 11/08/2003.

- ID.
In type of document IdemHotel comes with the types supported by the DGP under the law the
law of 11/08/2003.

If you have signed annual maintenance, new versions will be updated these files.
Otherwise, you must do it manually.
-------------------------------------------------- -----------------------------

When entering a document number, IdemHotel checks if a customer with this issue.

Using "click" on the "tab" that puts Birth data for viewing on the admission form and the
special list for the police. Indicate the following:
Date of Birth, Name of mother and father, Town, Province and Country of birth of the client.

We can enter information about the Company's Data belonging to the client. IdemHotel give
us the option to check the reservations we want that customer to the company that is assigned
automatically.
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To do this we "click" on the "tab" Data Enterprise client file and assign the company to which
it belongs. If there is no button we created from maintenance.

If we "click" on the "tab" Observations indicate any comments we deem appropriate to the
client.

Only if you have checked the option accounting Liaison Company activated the "tab"
Accounting for accounting to allocate a customer account, so you can export customer bills
(or a company assigned to the client) to automatically count them IdemConta (See section 5.6
.- Export Invoices to Accounting).

Only in the case of a company assigned to the client, active in the "tab" Accounting
accounting firm the Account field, where we assign an account book for the company that we
have assigned to the client, this will allow us to export the company's bills assigned to the
client. (See section 5.6 .- Export Invoices to Accounting)

When finished entering all the data, you must press the button (REC) from any of the "Tabs"
tab of the client, so that the client is archived in the database.

1.2.2 .- Search for a client.

There are two ways to find a client that is already discharged, to review or change any of the
information. Pressing the CUSTOMER, from maintaining IdemHotel files and asks if you
want to see all clients discharged so far:

1 - If you answer NO, the question of whether you want to see everyone, then see a browser
window to make your selection. We may search by Name, ID, Phone, Company, Country and
Month Birth, besides being able to combine these criteria.
To enter the first digit in the appropriate field when you "click" on the SEARCH button
IdemHotel F5-locate clients as we have checked the option starts ... or ... contains ....

Anyway, although we have located only a few customers, we can always see all the customers
by "click" on the ALL button.

The button will allow us to seek, at a time, a text name.

2 - If on the contrary, yes, the list appears with all those stored in the database, and you can
find one in particular, by pressing the SEARCH button.

Once customers located screen can do fast searches by other customers "click" on the
SEARCH button. In this window you can combine multiple search criteria such as name, ID
number, telephone customer and company that owns the customer, Citizenship and Birth
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Month. These criteria can indicate certain characters and locates IdemHotel clients starting or
containing the name or ID you have entered is checked according starts ... or ... contains ...

If we want more search criteria by "click" on the Settings button visualize an editor so we can
search and select the search criteria you want.
For example, we look for the name of the customer, the company that has been assigned, by
phone, E_Mail, birth month, etc.

Once located in the required Client list, with "double click" on it, enter the corresponding tab,
where you can change what we're interested.

In addition we can also print labels and Customer, Customer reports located by "clicking" on
the corresponding buttons.

Pressing the button will select the fields LABELS want to print on the label (eg customer
name, address, phone, ...) by clicking with the mouse on the field and dragging it to the label
on the right. We can also write a text and move it to the button label.

With the Report button we can make customer reports located by selecting the fields such as
address, phone, ....
We may change the attributes of the text of the report, such as font, color, ... both of the
header, and the report information and operations can be indicated in the total.

Using "click" on the button (EXPORT) from customers located screen, export the list of
clients we have selected all the information that has been assigned clients, a file out of
IdemHotel to use such information outside IdemHotel.

Moreover, the list of customers, can be sorted by many criteria by clicking the Sort button.

Example: Print labels to send cards to customers who were born in the month of October.

- First. Select clients who were born in the month of October. To do this we have two
possibilities:

A) From the File menu "click" on the Customer button and answer NO to the question of
whether you want to see everyone.
Birth Month field will indicate "10" for the month of October and will click on F5-SEARCH.
B) If we have selected all the customers to "click" on the Settings button.

In this case, indicate your search criteria Mes_Nacimiento by "click" on it and then from
column comparisons (right) select with a click the Equals option, and enter a "10" for the
month of October and we "click" the button CONSULTATION.

- Second. We will "click" on the button labeled.
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We will "click" in the Name field and drag it and hold the space reserved for labels, and
repeat the same for each customer data as necessary.
We select the layout and characteristics of the cloud.
- Third. We will "click" on the PRINT button.
 Printed labels for customers who were born in the month of October.

Now we can only stick the labels on the envelopes to send to those customers.

1.2.3 .- Modify a Customer data.

To modify the data of a customer, released previously, we must first locate, in the manner
explained in the preceding paragraph, and then just have to put the cursor where you want to
enter new data.

After making the necessary changes, will have to record them so that they are changed by
pressing the (REC).

1.2.4 .- Delete a Customer.

To clear the customer database stored somewhere, you have to select the list, with "double
click" on it and then pressing the button (CLEAR).
Prior to deletion, IdemHotel asked for confirmation and if the answer the affirmative, remove
it from the database.

1.2.5 .- Print Client.

We print labels for customers located and, reports of them doing "click" on the corresponding
buttons from the Customer screen located.

1.2.6 .- Client / Company.

In the section Client / Enterprise, companies can create all of the customers or travelers. In
this way we will have a database of clients and companies we only show the client the
company to which he belongs, if applicable.
To help in the authentication data, we validate the CIF of the company for Spanish
companies. Clicking the button

1.3 .- SERVICES.
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Normally the hotel, while providing room to Customers, provides a range of additional
services.

To access the general maintenance services, you must press the SERVICES button within
files. Once inside, proceed to the creation, deletion or printing them.

Only if you have checked the option Link to Company accounting displays the "column"
accounts.

PHONE ROOM and services which are used for automatic billing of the rooms can not delete
them or mark them as inactive.

1.3.1 .- Create a new Service.

If you want to register some type of service provided by the Hotel, will have to "click" on the
NEW button and type the name of the service you want to create and assign the VAT rate that
corresponds to when creating the service IdemHotel reservations automatically assign billing
for the VAT due.
We may also indicate whether the service is active or inactive by selecting the Active SI field
activities and not idle.
Only in the case that since we create a new service reserves IdemHotel not locate those
services that are inactive.

Only if you have checked the option Link to Company accounting displays the "column"
Account Accounting to assign an account accounting services, so you can export the invoices
that have these services billed to automatically count them IdemConta ( See section 5.6 .-
Export Invoices to Accounting).
IdemHotel, if we do not indicate anything, the account assigned to service accounts in the
Account field mapped File Sales Company, but we can change that account.

For this to be archived in the file to be pressed the REC button, and automatically be stored.

1.3.2 .- Delete a Service.

If what you want is to erase any archiving service, will have to select the list, with "click" on
it and then press the CLEAR button.

Before performing the deletion, IdemHotel will confirm, to ensure that there is a mistake.

1.3.3 .- Print File Services.

You can print the list of all archived Services IdemHotel, just by pressing the PRINT button.
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1.4 .- ROOMS.

All the rooms that owns the Hotel should have a different number and must belong to a
certain type (single, double ,...), depending on the features that meet every one of them.

To enter the maintenance ROOMS, press the button with this name, of files.

Once you enter it, the list that is displayed with all rooms on file, is sorted by number of
rooms, but also have the ability to sort by type, by "clicking" in the area where it says select
number and type .

1.4.1 .- Create a new room.

To register a person, it will take "click" on the NEW button and enter the maintenance, which
will have to type the number and type to which it belongs.

We can separate the rooms and floors. To do this we need to create first and then put each
plant room concerned.
To create the silver will click the button next to the plant.

For us to create a virtual room, a restaurant, ..., we will de-select the police report. Thus,
when list or send information to police these rooms are not included.

As always, we must save the data in IdemHotel, pressing the (REC).

1.4.2 .- Find a Room.

To quickly find a particular person, having the ability to sort the list, as noted earlier,
according to the number and type of room, this task can be performed more easily.

1.4.3 .- Room Update.

To modify data in any particular room, so you just have to find it in the list, as explained in
the previous section, and make "double click" on it.

Automatically displays a screen where the data appear to be modified room.

Once the desired changes, press the button (REC) for these are modified in the database.

By changing the type of a room that already had reservations, IdemHotel proceed as follows:
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1) The reservation of the room, from the date of the trip, you can change the new type of
room.
2) Reserves the day before or come from a day or previous day (s) shall be maintained in
reserve the guy that worked, but when viewing on screen room will look like the new type.

1.4.4 .- Clear a Room.

To delete the file rooms, one in particular, will need to find, select and making "click" on the
button (CLEAR), will be removed from the database.

The application, prior to deleting it, ask for confirmation to make sure that this is not an error.

If the person to be erased, is on file in another file, such as the Reserve, IdemHotel not allow
deletion until it is erased the reservations that are made for that person.

1.4.5 .- Low / Cancellation of a room.

Now we can make the rooms as LOW / Cancelled. It allows us to address the fact of the
cancellation of a room for any reason, such as: turn it into high, unite with another, ...
Thus, keep all the historical information of the room, but not displayed in the grid, stocks,
charts, ...

1.5 .- PRICES Room.

IdemHotel offers the possibility to set the price lists, so adaptable, allowing almost any
possibility.
The creation of price lists to invoice automatically with the correct price, just select the rate in
the reserve, IdemHotel invoiced dates, room type, use, diet, ...
To do this we must establish in order the following:

Rate - Room Type - Meal Scheme
Using the Room - Period dates prices.
Billing service. - Price per service. - How to apply service.

With the Rates button fields, type of room, diet and use of room we can access the
corresponding files to easily create, delete or modify Types, Uses of room and catering.

Mark the View All if we view the All prices for all dates, or option and indicate the dates
between date range From To where we want it understood the list of Room Rates.
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From the "Create new tariff" can create the seasonal calendar dates to automatically apply to
each fee, which will create the calendar for each tariff with a single click.

1.5.1 .- Assign a new room rates for a fee.

To assign a new room price at a rate necessary to select a rate.
Within the selected rate should indicate:

- Room Type - Meal Scheme - Using Room
- Term - Service (s) to check

 thus can generate multiple combinations within the same rate.

Prices can create rooms that do not include catering. For this to create the price we have
selected in the Food System field None.

To create a new price, we will "click" on the F4-NEW button. Indicate the duration of the
price assigned to the rate and amount:

- Date from: date from the validity of the price.
- Date To: End of the validity of the price.
- Room rates for the dates indicated.
- Application form for that price. Here we have several alternatives:

 

 The price will be multiplied for each night of the reservation.
 The price will be multiplied by the number of persons and nights.
 The price is multiplied by the number of children and nights.
 The price will be charged once, regardless of the nights of the reservation.
Once all the data, you must press the F2 button and automatically SAVE the new price is
stored in the selected rate.
From version 2007.1, you can set / create the fee directly from the reserve.

IMPORTANT:

In Reserves, assigned IdemHotel rate prices according to the date, room type, diet and the use
of the room on the booking.

Example 1:

- Type of Room: Single - Food System: Full board
- Use of Room: Normal - Period of validity: 01/01/2002 to 06/15/2002
- Price: 95 euros
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Example 2:

- Type of Room: Double - Food System: Full board
- Use of Room: Extra bed
- Period of validity: 06/15/2002 to 09/15/2002 - Price: 115 euros

1.5.2 .- Find a Room rates.

To find a Room rates must first select a rate, then the type of housing, diet and use of the
person belonging to that rate and mark the View All or Enter Dates as we wish to view prices
or only between the dates select.
Once visualize the price list will "click" in which we are interested.

1.5.3 .- Edit Room Prices.

For any change in the price of a room, will be selected, in the manner explained above, by
"clicking" on it. And by the desired changes.

Finally, we must press the F2-record, and so the changes will be filed in the file.

Another way to change a room's price with DOUBLE FEES button to modify the prices or,
only the dates you selected period, a rate at a time. After pressing the button will follow the
following steps:

First select the rate we're going to use as a basis for modifying a fee, which may be the same
or another.
Second, we will mark the Modify Existing rate.
Third, select the rate we want to modify, making "click" on the drop-down list price.
Fourth, state if the amendment is to increase or decrease, and if it is percentage or amount and
indicate in the appropriate field.
Fifth, give dates to the period since we want to change the prices of the selected rate.
Finally we have to press the F2-DOUBLING RATES, automatically changing the rate
IdemHotel selected based on the tariff chosen and the criteria.

1.5.4 .- Double Room Rates.

Using "click" the button RATES DOUBLE visualize the same screen as in paragraph 1.5.3 .-
Prices Changing Room, from which we can duplicate a fee between the dates you select.
Once in this screen first select the rate that we will use as a base to create a new tariff by
selecting from the dropdown list.
Second, checking the new rate.
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Third, indicate the name of the new tariff rate in the Title field.
Fourth, indicate whether the new rate will be increased or decreased, and if rates or amounts
over the rate used as a base and indicate the appropriate field.
Fifth, give dates From To where we want it understood the new rate.
Finally we have to press the F2-DOUBLING RATES, IdemHotel automatically creating a
new rate based on the tariff chosen and the criteria.

1.5.5 .- Clear a Room rates.

To delete a first room rates at select from the list of prices for the rate selected by "clicking"
on it, and then press the CLEAR button.

1.5.6 .- Establish fare calendar seasons.

If you already have created a seasonal calendar year, we only need to click on the "Create
New Rate. Calencario Seasons" and will create for dates as we have created. So we'll just put
seasonal prices of the selected rate.

1.6 .- TYPE ROOMS.

In the Hotel there are several types of rooms, therefore, by pressing its rooms, from the File
menu, general maintenance appears where you can enlist, delete, print, etc., Any kind of room.

1.6.1 .- Create a new kind of room.

If you wish to register a type of room, will press the New button, type the name of the new
type, and finally, click the Record button.

1.6.2 .- Deleting a kind of room.

To delete a room type, you have to select it, making "click" on it and press the CLEAR button.

Prior to erasure, and application always asks for confirmation, if the answer is yes and this
type is not filed in other files, such as Rooms and Rates Rooms, then removed from the
database, but by the Conversely, if it is stored in another file, the Management will report
back, and will not allow deletion, until it is removed from other files.

1.6.3 .- Print Room type file.

IdemHotel also gives the opportunity to print the list of all room types previously discharged
by pressing the PRINT button
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.
1.7 .- TYPE CUSTOMERS.

The Hotel can be several types of clients, therefore, pressing the TYPE CUSTOMERS, from
the File menu, general maintenance appears where you can enlist, delete, print, etc., Any type
of customer for so we can classify customers according to interest us.

1.7.1 .- Create a new type of customer.

If you wish to register a type of client, will press the New button, type the name of the new
type, and finally, click the Record button.

1.7.2 .- Deleting a Customer Type.

To delete a Customer Type, you have to select it, making "click" on it and press the CLEAR
button.

Prior to deletion, IdemHotel checking whether it is used in other files, such as customers,
then removed from the database, but on the contrary, if it is stored in another file, inform
IdemHotel this, and will not allow deletion, until deleting the files in which it is used.

1.7.3 .- Print file type Customer.

IdemHotel also gives the opportunity to print the list of all client types previously discharged
by pressing the PRINT button.

1.8 .- USERS.

Therefore, access to such maintenance, need to do "click" on the Users button from the File
menu.

Since this file indicates the group that owns each of the users, who will determine access to
different processes.

1.8.1 .- Create a New User.

To register in the database to a User, you must first press the New button and then proceed to
enter all data on the appropriate tab. These data are:
- Name of the user, which will be identified upon entering IdemHotel.
- Key. Using "click" on the button (KEY ACCESS) can enter the user password. (See section
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V-2 .- Access IdemHotel). When you enter will be invisible and are introduced as the digits
will appear as asterisks to bring greater security to the user.
- Name it.
- Group to which the user belongs. From here you can create different groups.
- Idle option is selected when you go to terminate the User.

When finished entering all data in this tab, you will burn for the new user is on file in the
database by pressing the REC button.

1.8.2 .- Find a User.

To search for a user registered in the previous management, the procedure is the same way as
customers, then selecting from the list, the user in question.

To enter the desired User tab, you have to double "click" on it and display the information
IdemHotel thereof, such as: User name, Name of the Group and it belongs to.

Since then, may make modifications, if desired, without forgetting, finally, save the changes.

1.9 .- AGENCY

Agencies that believe in this file will help us to map them to reservations and check the
rooms and such agencies as the guests occupying the room come to travel agency.

Agencies can create, modify and delete, the file by clicking the button Agencies AGENCIES
F9 from the File menu or the tab button from the Reservation.

1.9.1 .- Create a new agency.

To register a new Agency will press the NEW button and fill in the details of the document,
such as:
Name, Address, Postal Code, City, State, Country and CIF.
Using "click" the button phone can create both phone and fax numbers, and email addresses
related to the agency.

In the field Assigned Room rate indicate the rate we use to the Agency. This rate will be
assigned automatically to backup IdemHotel when assigning the agency in question.
Anyway we can select the rate that we are interested from the reservation form.
If we want to de-select the tab Rate and leave the agency without any rate assigned will
"click" on the button (CANCEL).
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In the field Assigned service fee rate indicate that we will use for the Agency. This rate will
be assigned automatically to the service IdemHotel when assigned by the Agency in the
reserve.
Anyway we can select the rate that we are interested in the information services.
If we want to de-select the tab Rate and leave the agency without any rate assigned will
"click" on the button (CANCEL).

In the Payment field assign the Form that the agency will pay the room.
If we want to de-select the Payment tab and leave the agency without any form of payment
assigned will "click" on the button (CANCEL).

Only if you have checked the option accounting Liaison Company activated the "tab" to
assign an accounting ledger account to the agency, so you can export the invoices for the
agency to automatically count them IdemConta (See section 5.6 .- Export Invoices to
Accounting).

Once all the data, you must press the button (REC) and automatically be recorded in
IdemHotel the new agency.

1.9.2 .- Find an Agency.

There are two ways to find an agency that is already created, to view or change any of the
information. Pressing AGENCIES, from keeping files or tab button from the Reservation,
IdemHotel ask if you want to see all clients discharged so far:

- If you answer NO, the question of whether you want to see everyone, then see a browser
window.

- If on the contrary, yes, the list appears with all that are stored in the database.

Once customers located screen can do fast searches by other customers "click" on the
SEARCH button. In this window you can combine search criteria and CIF name. The options
start with ... or ... contains ... IdemHotel locate customers who begin or containing the name
or ID you have entered.

If we want more search criteria by "click" on the Settings button visualize an editor so we can
search and select the search criteria of interest.

Anyway, although we have located only a few agencies, we can always see all the agencies
making "click" on the All button.

Once located in the desired Agency list, by "double click" on it, enter the corresponding tab,
where you can change what we're interested.
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When we entered all the changes, press the RECORD button and will automatically save your
changes at the Agency.

In addition we can also print labels and Clients, Reports of the same by "click" on the
corresponding buttons from the display located Agency.

Pressing LABELS display a window where you select the fields related to the database
IdemHotel you want printed on the label (eg agency name, address, phone number, ...) by
clicking with the mouse on field and dragging it to the label on the right. We can also write a
text and move it to the button label.
In the bottom of the window we see options to change the attributes of the selected fields,
such as font, color, ... clicking on the Layout tab select the characteristics of the cloud as a
number of them, label size, portrait orientation or horizontal ...

With the Report button can make a list of agencies that have in IdemHotel introducing therein
the information fields on the database of agencies such as address, telephone, ..., by "double
click" on which we are interested to report. The row heading is the title of the selected field in
the Detail row visualize the information we have on IdemHotel on the field, although in this
row can indicate a text, and not viewing the same information for the selected field. In the
Total row operations we can do.
We may change the attributes of the text of the report, such as font, color, ... both of the
header, and the report information and operations can be indicated in the total.
Once we made the report can print it, save a file out of IdemHotel, ..., selecting the
appropriate option from File on the toolbar at the top of the screen.

Using "click" on the button (EXPORT) from the display of the branch locations, we will
export the list of agencies that have selected, with all the information you have allocated
customers, IdemHotel a file out of order to use such information outside of IdemHotel.

Moreover, the list of agencies, can be sorted by any criteria by clicking the Sort button.

1.9.3 .- Change Agency data.

In order to change an agency which is registered in advance, we must first locate, in the
manner explained in the preceding paragraph, and then just have to modify the desired data.

After making the necessary changes, will have to record them so that they are saved by
pressing the REC button.

1.9.4 .- Delete an Agency.

To clear the database stored any agency, must be selected from the list, with "double click" on
it and then press the (CLEAR).
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Prior to deletion, IdemHotel asked for confirmation and if so, remove it from the database.
IdemHotel not allow us to eliminate an agency that is assigned to a reservation.

Quotas 1.9.5 .- Agencies.

Since a module, it must be contracted separately.
Saves quotas to the various agencies involved.
This way from the grid and / or book as we know are the reservations and quotas at all times

1.10 .- PAYMENT.

In the hotel may have several payment therefore by pressing PAYMENT, from the File menu,
general maintenance appears where you can enlist, delete, print, etc., Any form of payment
for and reservations can indicate which is the payment method you will use the client to pay
the bill / s of the reservation.

1.10.1 .- Create a new Form of Payment.

If you wish to register a payment, will press the New button, type the name of the new
payment, and finally, click the Record button.

1.10.2 .- Delete a Payment.

To delete a payment, you have to select it, making "click" on it and press the CLEAR button.

Prior to erasure, and application always asks for confirmation, if the answer is yes and this
form of payment is not filed in other files, such as reservations, then removed from the
database, but instead if it is stored in another file, IdemHotel inform, and will not allow
deletion, until deleting the other files.

1.10.3 .- Payment Print file.

IdemHotel also gives the opportunity to print the list of all Forms of payment previously
discharged by pressing the PRINT button.

1.11 .- diet.

The Hotel can be several types of diets as half board, full board, etc., Therefore, pressing the
diet, from the File menu, general maintenance appears where you can enlist, delete, print, etc.,
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any diet that will use the hotel so that we can indicate in the reservation which is the regime
that we apply to the booking client.

1.11.1 .- Create a new diet.

If you wish to register a diet, will press the New button, type the name of the new diet, and
finally, click the Record button.

1.11.2 .- Deleting a diet.

To delete a diet, you have to select it, making "click" on it and press the CLEAR button.

Prior to erasure, and application always asks for confirmation, if the answer is yes and this
diet is not filed in other files, such as reservations, then removed from the database, but on
the contrary, if it is stored in another file, IdemHotel inform, and will not allow deletion, until
deleting the other files.

1.11.3 .- Print file diet.

IdemHotel also gives the opportunity to print the list of all the diets previously discharged by
pressing the PRINT button.

1.12 .- PRICES services.

To enter the maintenance of the Price of the Services, you must press the button RATES
SERVICES, maintenance of files.

From here you can create, delete or modify the Service Fees entering its file with the button.

To view the complete list of prices for a room rate will only have to select the appropriate rate.

1.12.1 .- Create a new service rates.

To create a price for a service first have to select a service fee, making "click" in which we
are interested in the dropdown list.
Once selected, the fee will "click" on the Service that we want to introduce the price,
activating the service costs € field and entering the price in this field.
Once all data typed, you must press the RECORD button and automatically F2 is stored the
new service rates at the selected rate.
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1.12.2 .- Find a service charge.

To find a Room rates must first select a rate, displaying a list of prices that we have created
for that rate.
Rates but we have not allocated money for the fee of the price visualize zero.

1.12.3 .- Edit Room Prices.

To make any changes in the prices of some services must be found first, as explained above,
and select it, making "click" on it.

After selecting the price, proceed to make the appropriate adjustments.

Finally, we must press the F2-Record, and so the changes will be filed in the file.

Another way to change a room's price with DOUBLE FEES button to modify the prices, a
rate at a time. Once you press that button the following window:

Once in this screen first select the rate we're going to use as a basis for modifying a fee,
which may be the same or another.
Second, we will mark the Modify Existing rate.
Third, select the rate we want to modify, making "click" on the drop-down list price.
Fourth, state if the amendment is to increase or decrease, and if it is percentage or amount and
indicate in the appropriate field.
Finally we have to press the F2-DOUBLING RATES, automatically changing the rate
IdemHotel selected based on the tariff chosen and the criteria.

1.12.4 .- Duplicate service charges.

Using "click" the button RATES DOUBLE visualize the same screen as in paragraph 1.12.3 .-
 Change Service Prices, from which we can duplicate a fee so the price will double that rate,
between the dates you select.

Once in this screen first select the rate that we will use as a base to create a new tariff by
selecting from the dropdown list.
Second, checking the new rate.
Third, indicate the name of the new tariff rate in the Title field.
Fourth, indicate whether the new rate will be increased or decreased, and if rates or amounts
over the rate used as a base and indicate the appropriate field.
Finally we have to press the F2-DOUBLING RATES, IdemHotel automatically creating a
new rate based on the tariff chosen and the criteria.
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1.12.5 .- Delete a service charge.

To delete a first room rates at select from the list of prices for the rate selected by "clicking"
on it, and then we will remove from service the Price field and click the button F2-RECORD.
You can remove the price of the service, to remove the service have to do it from the
SERVICES file.

2 .- BOOKING / RECORDS / invoices.

This is maintenance work where 90% of the time. For from him have access to the reserves,
Invoices, Services, ...

In the maintenance of reserves, we can see bookings made in a particular month, a week or
two weeks, selecting the appropriate button.

IdemHotel show all Room Types Reservations selected between the dates you have entered.

- Consultation on Reserves. To quickly view archived reservations in a given period of time
to be pressed the Previous, Current or Next, as desired with the following buttons. Below
these buttons are indicated for the calendar dates to visualize.

Reservations on the grid shows the day of the month, two weeks or week as we have selected.

We distinguish the following situations, Room:

- Green, the Pre-booked - Color (bicolor) Confirmed green and red.
- Color Orange among workers. - Color magenta bills.
- Blue cobras. - Inactive for reforms, damage, ...

When we have selected the option View Weekly or Fortnightly Days by "click" the button
will display the largest calendar.
If you have checked the Show clients, selecting a "click" on one day, we might see (the) client
(s) and a symbol that will indicate if the client enter, leave or remain in the same room, the
selected day.
Using "click" on the client's name shows their data.

- Display data from a backup. Using "click" on a reservation visualize data such as the reserve
price inclusive of VAT, the customer, the number of people occupying the room, ...
- Notification Birthday. When you "click" on a reservation, we will remember if the client
fulfills years within the period specified in the statement COMPANY.

Buttons accessible from this screen.

IMPORTANT NOTE:
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From version 2005.6, you can click on the grid with the right mouse button will show a
dropdown menu from which to do all the functions listed below with the buttons, plus:

If we click on an existing reservation
- Log directly to the billing of the Selected Reserve.
- We reserve double that in another day and / or room. For those regular customers, we do not
have to repeat the process each time.

- Zoom grid. Only options View Weekly or Fortnightly Days

- Consultation Fee. Shows rates Room Rates. The we will have created previously (see
Section 1.5 .- Prices Habit.)

- Disable yellow line. Disable the yellow line.

- Print. Using "click" that button or by typing the F8 key, you can choose between 4 options:
1) Listing Service Chief (e) 2) List of clients x days (high) 3) Print the grid 4) party flyer and /
or Admission tab of the Selected Reserve. The latter only if we have marked as occupied the
room.

- Graphics. Statistics rooms. What we see (Column, Image, Points and Lines), and, by week,
month or year.

- Changing the current room reservation to another free. We show you the vacant rooms to
which we can change the Selected Reserve.

- Exchange of the current room reservation to an existing. Show us those rooms reserved for
that we can change the current reserve selection. (NOTE: You may not change rooms and
invoiced)

- Inactive. Allows you to mark rooms, dates, and inactive.

- View Clients booking. Show clients the reserve

- Historic Reserve. Reservations can locate different criteria.

- Search by pager. Search for stocks by pager number of the hotel or agency.

- Reservations canceled. Cancellations Report
Clicking these buttons will change the status of reservation, without having to enter it.

- Charged / Not Charged.
- Busy / No occupied.
- Billed / No Billed.
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Each time you record a reservation as EMPLOYED IdemHotel a number of tickets allocated
to the reserve, which is printed on card of the traveler and provides no record sheet for the
record book party flyer ..

- New or modification of the reservation. NEW Just For Clicking this button or press F2. To
change, we will click on the desired reservation and then click the button or press F2.

- Invoices. From here we can find or create a new invoice.

- Remove reserves. (See section 2.1.7 .- Delete reserves)

- Groups. In the case of a group, we display this symbol on the top. If we know the rooms that
belong to that group and / or change the group name, we click on this button.

2.1.1 .- Waiting List

The waiting list can be useful for various functions: Some examples.

1) To record the requests of reservations has not been possible to not be available at that time.
2) Reserves that we are not clear or no progress.

Thus, in the event of any cancellation of a reservation, we can access the waiting list and
decide who to assign the reservation.
To do this simply by clicking on the button to go from Standby Reserve, it will automatically
erase himself from the waiting list for transfer.

Using "click" the button (waiting list) agree to a waiting list of stocks from which we can
create new records, delete, print and sort the waiting list (Date, home reservation ...).

To create a new record in the reservation waiting list will "click" on the NEW button. Seek or
create the customer to book, then enter the number of rooms planned to book, the start date of
the reservation and the days of the reservation.
In the field observations indicate the additional information of interest, such as customer data,
payment, type of room, ...
Finally, we should do "click" on the REC button to be stored in IdemHotel.

If we select with a click track of the waiting list then we can move from one on one with the
buttons or pressing the "arrow up / down the keyboard.
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Pass Wait List Reservation. It is only necessary to click on the button to go from Standby
Reserve, IdemHotel will create a new log book with data from the waiting list and deletes the
selected from the waiting list.

To delete a record from the waiting list three ways:
1 .- To "click" on the record that we want and then "click" on the CLEAR button.
2 .- To "click" on the button and select DELETE PERIOD From To start dates subject that
corresponds to the records we want to eliminate.
3 .- In the case records that have started before a week to go to the Waiting List, IdemHotel
gives us the option to delete all those records.

2.1.2 .- Registration of reserves.

This support allows us to view the report IdemHotel is generating, automatically, every time
we give high, modify or delete a reservation.

This report includes the following information:

- Date and time of each reservation eliminated.
- User name that was deleted.
- The customer's name / s of the reservation.
- Group to which it belongs, if applicable.
- Agency assigned to the reserve, if applicable.
- Date of entry and exit of the book removed.

When the report reaches approximately 200 pages IdemHotel warn you about this situation
and gives us the option to Save report IdemHotel outside.
For us to keep the report blank IdemHotel initialize the report and also automatically saved in
text a copy of the report.

Similarly, with the button (SAVE) can save the report in a file out of IdemHotel whenever we
want, indicating where we want to save.

2.1.3 .- Create a new Book.

To make a booking to do "click" on the starting day of the new reserve, reservations map and
then to "click" on the button (NEW BOOK) or press the F2 key on the keyboard.

Visualize a new reserve, which will have to enter all the information requested, such as:

- Name of the Customer. To register all guests occupying the rooms can be assigned to each
reserve all our customers want. To assign customers:

1 .- We will "click" on the F5 button to clients.
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2 .- From the window to assign customers have several options to select customers
2.a. - View all F2-SELECT customers.
2.b. - Create a new client by "click" the button, create the client as explained in Section 1.2 .-
Clients.
2.c. - Enter the first digit in the Name field when you "click" the button IdemHotel locate
clients as we have checked the option starts ... or ... contains .... We can also seek for their ID
card number.

3 .- Once selected, the client will "click" in the F2-ADD button.
If you are a paying customer, IdemHotel warns us of this.
4 .- repeat the same process for all customers who want to assign to the reserve.
 
 Once we entered the name of clients or customers in the form of the Reserve, we can see
their data in the Customer Data Box
Using "click" on the button (Search Book) we find all the reservations of the customer or
group selected from the given dates.

- Entry Day.
IdemHotel shows the day that is marked as initial reservations on the map.
- Departure Day.
By entering IdemHotel shows today's date following the day of entry.
The departure date may be selected as input for a new reservation, for example if a client
leaves the room once in the morning and the same room is occupied by another client on the
same day afternoon.

- Number of people who will occupy the room.

By clicking on the buttons, as appropriate, may change the date of entry, exit or the number of
people occupying the room.

- Number of children who will occupy the room.

- Number of cribs that have the room.

- Use of room. We can indicate the use made of the room.
Eg double room for two people would use NORMAL.
Eg Double room for one person would use INDIVIDUAL.

- Diet. Assign the diet corresponding to the reservation, for example if half or full board. To
do this you select from the list. To override will "click" on the button (CANCEL)
If you have not created the diet or want to change any, will "click" on the button and enter the
file of diet.

If you have selected a fee, both the allocation of use of room as the diet will affect the price
IdemHotel allocated to this reserve. (See section 1.5 .- Price Rooms).
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- The cost of the room.

According Rate .- If you want to charge the Customer the room at the rates established in the
room rate, you must check the option price as Tarifa.
IdemHotel assign the price or prices that we have created for that rate. (See section 1.5 .-
Prices Rooms), as the use of the room, diet and Date Book ..
When you select the client automatically select the rate assigned in the tab. Likewise, if we
select Agency IdemHotel automatically assign the rate shown on the form the agency.

 Manualmente.-IdemHotel allows us to assign the prices you want. To this must be de-
selected the option price as Tarifa.

- Agency.
If the client is able to assign agency-clicking the blank field for agency, display a list in which
we "click" on the agency of interest.
We see the phones and others by "click" on the button.

- Payment.
Two field to indicate the method of payment:
1 - The next to the room rate indicates the payment of the stay. By assigning the customer to
the reservation, IdemHotel select the payment method is assigned to the client's record.
2 - The button below indicates provisional sum payment of that amount that gave the
customer account.

- Proof of deposit.
This button allows us to print / email a proof of the objects supplied by the customer in the
hotel deposit.

- Proof of reservation.
This button allows us to print / email a proof of reservation to the customer. (Possibility of
including signature)

- Delivery to Account.
In this field indicates the amount paid on account and the date it occurred, and the payment
form that has made the payment on account.
Only if we have given down payment and visualize the button below with which we can print
or send by e_mail, respectively, a receipt for the amount paid for the reservation and stating
the customer name and tax identification number assigned to the reserve amount and Subject
characteristics (type and use of room, number of occupants, date of entry and exit from the
room) The text is editable by the user. (Possibility of including signature)

- Registered. By checking this option means the customer has occupied the room reservation.

- Copper. By checking this option, the reservation is considered recovered.
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- Observation of the Reserve. Area to write any comments of the Reserve. If you want to
record without leaving comments, we will "click" on the button.

- Search by pager. Search for stocks by pager number of the hotel or agency.
In part to find, we can keep all the locators that refer to this reservation.

IdemHotel allows two types of pagers:

1) The hotel's own (internal). When we control with a single reservation code.

Internal code locator consists of 3 parts:

First three digits: Prefix that we have stated for the company. (Eg, HFC) IdemHotel assigned
by default the first three letters of the Hotel.
Following four digits: The first two are the month and the next two year is generated by the
locator. (Example: 0104 = serious month January 2004)
Next up to eight digits, the serial number. (Eg.: 112)

In this example, the locator would be: HFC0104112

2) The agencies assigned by (External). When agencies give us your code locator.

In both cases, we can find you retained pagers and printed on invoices.

Once you have entered all the details of the booking, you must press the RECORD button.
IdemHotel will show all customers who have selected the room to select one. Then we will
"click" in the F2-SELECT button, recording customer IdemHotel selected as principal client
of the booking.
If the client is recorded Moroso (See section 1.2 .- customers) will see the tab for the book a
"tag" remembering this circumstance.
IdemHotel gives us the option to print the entry form for all clients assigned to the reserve or
just the client we select.

Since the 2010 release, a new Documents tab. In this tab, you can save any document in order
to later retrieve both, send email, ...

Only if the reservation is NEW, once booked, instead of pressing the REC button, we will
"click" on the Burn button groups displaying a window to select the available rooms and
book them with the same data as the reserve original. Then we can select the reservations that
we are interested in and modify the data needed. So we can book an entire group of people
coming together from a single booking.
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- OCR-Recognizer documents. If you purchased the OCR module, just need to click on the
button and follow the instructions. In this way we create the client file and assign it to the
reservation.
Customer tab will keep the photograph and signature (if any identification document) and
copy the document itself.
This module allows you to recognize identification documents such as identity card, driving
license, residence permit, ... more than 100 countries.
If it detects that the scanned document has asked both sides to turn the document to recognize
it.

When the return to the document, click on the image or press the Return key.

After the scan, perform the OCR process and show us the data.

And only remains for us to confirm that all details are correct. If any data should be incorrect
could change it from here.
In the event that IdemHotel verify that the client already exists, it will show in red do not
match the data (if any) with what we have on the record.
The utility serves to capitalize on all fields of the tab.

2.1.4 .- Find a Book.

To find an archived Reserve have two different ways:

1.-numbers, if known, the type of the Reserve Room, and then search the map using the
buttons.

Is selected as F7-month or F5 F6-half-week, the map will show the booking reservations for
the period.
We can also indicate a date that we see.

Once you have found the Reserve, with "click" on it, appears at the bottom of the screen, the
name of the client who made the booking, the date of departure, the price per night, ... .

If you want more information about it, by "double click" on it, you will see the tab for the
Book with all their archived data.

2 .- Another way to find stocks is making "click" on the button. We can locate a customer
reserves or reserves that belong to a group.
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To find the stocks we indicate:
- Client Name reserves we want, only if we seek reservations for a client.

- Name of the group. Will mark the Group option and enter the name of the group of stocks
that look, just in case you look for stocks of a group.

- Dates you want the search to fall. (Next to the fields where we put the dates there are
buttons that will facilitate the task, going from one date to another or placing the current date,
without having to change us the same.)

- Reserved, Busy, or both. Options to find stocks that have been employed, which are still
vacant or both respectively.

When we set these criteria will "click" on the F5-SEARCH button and locate IdemHotel any
reservations that meet the search criteria.

Displayed within the reserves located in the arrival and departure and, if it is occupied or not.
If we make a click on a reservation visualize the same data as the price, days of booking, and
customer data.

Only in the case of seeking bookings from the booking calendar can be selected to modify the
reservation, billing, etc ..., by "clicking" on the button

2.1.5 .- Modify data in a Book.

To modify a reservation, you should first search, as explained in the previous section, and
then doing "double click" on it, all display the same data in order to be modified.

When you have made the necessary changes, you must press the RECORD button so that they
are stored in IdemHotel.

We can not change the reservation if the booking is invoiced.

2.1.6 .- Change Room reservation.

"Changing the current room reservation to another free. Using "click" the button will show
those free rooms to which we can change the currently selected book.

-Exchange reserve in the current room to an existing. Using "click" the button will show
those rooms reserved for that we can change the current reserve selection.

NOTE: The reservations can not change invoiced.
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2.1.7 .- Modify a group reservation.

To change the booking or even add rooms to a reservation, after modifying the data in a
group of stocks, we click the Modify button group.

We can also change a reservation that belongs to a group as follows:

 Modify one by one the reserves. Select the reserve double click and when we made the
necessary changes, you must press the RECORD button so that they are stored in IdemHotel.

 Modify all group reservations. In this case we can only change some details of the booking:

Registered. IdemHotel gives us the option of registering
- All rooms at the group at a time.
- ONLY the reserve room selected.

Charged. IdemHotel gives us the option to make charged
- ALL group bookings.
- Only the selected reserve.

Down payment. Once given the amount, date of delivery and Payment
of the down payment, clicking on the button IdemHotel gives us the option
record the down payment
- ONLY in the Selected Reserve.
- In ALL stocks belonging to the group.

2.1.8 .- Delete a reservation.

To delete a booking database, there are two ways:

1 .- Select the reservation first, by "double click" on it and then press the CLEAR button on
the tab of the reservation.

2 .- Select with a click backup and press the button (CLEAR) of the booking calendar screen.

In both cases, IdemHotel are prompted to ensure that there has been a mistake of the user by
deleting the reservation and invoices and services that have created the reservation.

If the reservation have bills grouping several room reservations, IdemHotel stocks erase all
the invoice after notice of this situation and ask for confirmation.

If you delete the reservation belongs to a group, proceeding in the same way explained to
delete reservations but also IdemHotel gives us the option to delete
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- Only the Selected Reserve, with the CLEAR button RESERVE.
- All bookings which are members of the Selected Reserve, with the Delete Group button.

2.1.9 .- Inactive rooms.

If there are rooms that are not going to be available to the public for repairs, alterations or any
other reason, IdemHotel gives us the option to make these rooms as inactive, so the room can
not be booked to any customer during the period of time not will be available.

If for example we will amend two rooms (103 and 104) and is expected to last a week (from
13/12 to 18/12), do the following so that the rooms can not be booked on this period:

1 .- Select Room (103) will not be available, making "click" on the rack in room 103
13/12/2002 calendar day reservation and click the button (SELECT RESERVE) or press the
F2 key on the keyboard.

2 .- Check will indicate the date (13/12/2002) and the output date (19/12/2002) and we can
put an eye on the reason for inactivity.

3 .- We will "click" on the button (INACTIVE).

From 13/12/2002 to 18/12/2002 will not be able to book the room 103, as the departure date
will not be marked as inactive so that on 19/12/2002 if we could reserve the room.

Repeat the same process for many rooms we want to mark as inactive because they are not
available.

Once the room marked as inactive visualize the image restricted to idle in the booking
calendar.
If you select a room with the button inactive (SELECT RESERVE) can change with it.

After the changes will "click" in the F2-REC button as usual to save the changes IdemHotel.

If we (Case A) change the period when the room is not available for such delayed work on
the reform or (Case B) cancel the inactivity of the room because for example there are no
such reforms or we made a mistake room, we will:

Case A. - "Click" in the room idle and button, change the dates of entry and exit of the period
really is not going to be available the room and then, as always, "click" in the F2-REC button.
Case B. - "Click" in the room and standby button, then "click" on the CLEAR button. In this
case the mark disappears (Room Off) and reservations may be selected.
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2.2 .- SERVICES.

IdemHotel also allows archiving services provided by the Hotel and the Client has used
during his stay there.

To do this we have two options:

1) From General Menu / Grid reserves.

This option arises for the massive introduction of services in the various reserves that we
have.

For this we can right from the main menu click the button: "Introduction of services."
Or, make reservations grid button

From here we enter the services provided in the rooms we want

The operation is the same as explained in option 2) with the only difference that for security
IdemHotel, alone, show rooms in the selected date have reservations. In this way will help us
avoid mistakes.

2) From within the reserve itself.

The difference with the previous method, we can only introduce the services provided in the
reservation of the room where we meet
After selecting the Reserve, press the Services button you will see a list of all the services
which have made use of the customer.
NOTE: SERVICES We create the room rate so you can check the room as a service.

2.2.1 .- Create a new Service.

To register a service in a certain reserve and for a specific client, you have to press the NEW
button, from the maintenance of the Reserves.
Once in the Services tab you must enter the data:

- Select a Service. In this field indicate the type of service we will allocate to the reserve.
To select the service do "click" on the magnifying glass or typing the first few digits of the
name of the service, displaying a list of all the services if there is more than one, and do
"click" on the service you want select.
In the case of creating a new service in the reserve, not locate the services that are marked as
inactive.
Services will be created from the maintenance of services located in the File menu, or
entering from the same chip by "click" on the button.
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- Rate services. Assign the rate we use to indicate the price of the service.
Only in the event that we allocated rate services in the information about the client or agency
selected in the reserve, will activate the following buttons, and by "clicking" on them allocate
the service rate assigned to the client or agency by which button you press.
- Date. Must be between the date of entry and exit of the reservation.
- Quantity. Indicate the amount of service provided.
- Cost. Indicate that it cost the service to the hotel.
- Amount to be invoiced. Price charge the customer for the service.
- Definition. Insert description of service provided by the hotel.
- VAT tax. In selecting the service shall automatically IdemHotel VAT percentage that is
assigned the corresponding service in the SERVICES file.
Anyway we can modify manually indicating VAT applicable.
- Repeat Text Option. If you deselect this option, the text to write in the last recorded service
will not disappear from the screen when we create a new service may be changed if we want.
When they have typed all the data, you must press the Record button, so that the data are
stored in IdemHotel.

2.2.2 .- Edit a Service.

To change a previously discharged service, you should first look by selecting from the list of
all the Services which Customer has used the allocation to the reserve, and by "double click"
on the service, you see all the data same in order to be modified.

We may modify all the fields mentioned in the section on creating a new service, except
when the service has been used in billing, in which case we can only modify the cost and
concept.

When you have made the necessary changes, you must press the RECORD button so that they
are stored in IdemHotel.

2.2.3 .- Delete a Service.

There are two ways to delete a service in a Reserve:
- Straight from the list showing all services discharged to the Reserve, pressing the DELETE
button.
- Using "double click" on the service you wish to delete within the list, appears with the
details of it and pressing the button (CLEAR), it will get deleted from the database.

In both cases, IdemHotel asks for confirmation before proceeding to erase the frame. On the
other hand, if the Service has used in turnover IdemHotel not allow deletion, if not cleared
before the bill is assigned to service or remove the service invoice buttons REMOVED
FROM THE BILL, which explained in section Bill.
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Select the invoice to "double click" and pressing the DELETE button, disappear from the
database. In both cases, IdemHotel asked for confirmation prior to deletion.

2.3 .- BILLS.

IdemHotel (version 2005.6) to invoice the room (s) to any customer, client / company and / or
Agency. Although this figure does not directly or indirectly in the room bill.

We access the billing since:

From the Grid:
1) Clicking the right mouse button on the reservation that we bill and selecting "Bill Room"
2) Clicking on the button in the lower buttons, you can find or make new bills of any room.

From the Book:
Clicking the button located at the bottom of buttons will show you, if any, existing bills or
new bills may make the room selected. Even gathering together with others.

When we create a new bill, first show us a screen for the demarcation of reservations to check.

IMPORTANT: If you want to check a reservation and billed, we will select "View Rooms
billed."

If we make only one room, we click the All button and then select the desired room.

This window will show us, if once inside the screen making the invoice, then click on the
magnifying glass button to expand your search criteria. Or, if you click on the button to add a
new room.

 2.3.1 .- Create a new Invoice.

We will display a window with all the information necessary to easily and efficiently bill.

Let's see all the features of this screen.

Here we see the search criteria used to select the rooms / reservations to check.
Clicking on the magnifying glass on the screen (blue), will show the search box in order to
modify it.
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 From here select the recipient of the invoice. It may be a Customer, Client / Company /
Agency ..

According to that we selected (Client, Client / company or agency) with the button can enter
relevant maintenance to additions, deletions or modifications.

If we have selected:
1) With the button we can access your file directly for editing.
2) With the button we can allocate for billing.

IdemHotel allows us to bill any customer, client / company or agency. To do indicate the
name or part of a bill and we will click on the magnifying glass on the right of the name.
Once located, select confirm and for billing.

 In invoice number will show "New" until we record the invoice. From here you can change
the date and the discount.

We show a first list of all the reserves located, according to selected criteria. At the top
indicating the number of stocks selected from the total of the list.

Options on this list:

Column One click, select or deselect the reserve for billing.

Any other column
One click, left button - it shows in the list below, unbilled services reserve.
Double click left mouse button - Select or Deselect the book to bill.
One click, right-Displays a menu from which you can do the following processes:

- Select All = Select all reservations shown in the list.
- De-Select All = Deselect all reservations shown in the list.
- Select rooms:
1) As we select Customer / Company / Agency. Clicking on the name, select all the same that
are on the list.
2) If applicable to a group, we will show the name of the group. Clicking on the name, select
all the same that are on the list.
- Remove from list billed reserves = Remove from list invoiced bookings.
- Remove from list selected stocks = not removed from the reserve list are not selected.
- Remove from List Room = removed from the list of reservations for the room selected.
- Customers = Under the latter option will show all clients booking.
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Clicking on any of the headers of the list will sort the list by that column (click
boton_izquierdo botón_derecho = descending ascending order)

 Other options from the buttons on top of this list

 - From here we see the reservation information
 - Allows you to check the accommodation services all selected rooms. IMPORTANT: Only
where it will not have created the accommodation service. From the bottom button we can
force to do so.
- If we are removed from the reserve list or wish to add any that are not in the list click here
and we will select.
- Allows you to include free text or a remark to the bill.

 IdemHOTEL incorporate, automatically, the discount you have to whom invoice. Although
we can change it.
Also, we have the possibility to indicate that the bill only affects discount on room service.

Each book will show the payment on account, if we change it, we will click on the floppy.

As seen above, clicking (left button) on any subject from the list will show the services not
billed on the list below.
Clicking on the dates that are at the bottom left of the list, or on the keyboard, arrow up or
down, passing from one reserve to another.

Here, as in the reservation list can do:

Column One click, select or deselect the check service.

Any other column
One click, left button - it shows in the bottom the text of the entire concept and allows us to
use the buttons on keeping the right ..
Double click left mouse button - select or deselect the check service.
One click, right-Displays a menu from which you can do the following processes:

- Select All = Select all the services shown in the list.
- De-Select All = Deselect all services shown in the list.
- Room service = Create Billing hosting services under reserve.
- Edit a Service = Enter the maintenance of services for editing ..
- New service = Create a new service in the Selected Reserve ..
- See other services billed = View other services and billed the reservation.
- Delete a selected service service = Clears ..
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We can also make these functions from the buttons on the right side of this list:

 

- New service
- Show billed services and booking.
- Modify service
- Billing accommodation reservation services
- Remove the service.

As we have seen, we can discharge, change or cancel your reservations services, without
leaving the preparation of the bill.

Now we can make to the reserve options:
- Mark as charged.
- Mark as billed

 

Once we have the bill ready with all the services we tested F2-click Save and the window will
show us to confirm number and invoice number. We can even change the date of invoice.

If you click directly on PRINT or EMAIL, without etching before, we show the same screen
above confirmation.

- Bill to a Customer, Group, Company or Agency.

IdemHotel allows a very easy and intuitive check all stocks of a single customer, group,
company or agency.

To do this we will click the button. And look for stocks of interest to us billing period.
IMPORTANT In the event that we may have already checked some of the reservations some
service, (Ejm. customer services and company accommodation or Agency) we check the
"View Rooms billed"

Once we have the list of reservations, we will click on Client, Company or Agency as to who
want to check.

We have 2 options:

IdemHOTEL v.2012.0 Page 52 of 81



1) Click on one of the reserves of the Client, Group, Company or Agency and will click on
the button, select the person automatically.
2) Put the name or part of it in the field to the left of the lens and once located, select it.

 
Now if we click the right mouse button on the reservation list, select the name of the Client,
Group, Company or Agency (Ejm. Lucas Fernández, José) in the Select rooms:

This will automatically select all the reserves, which are on the list, the Client, Group,
Company or Agency selected.

In this drop-down menu, you can select the option "Remove from list selected NO reserves",
which will eliminate the non-selected and allow us to work more safely.

We click the button to automatically generate the guestroom. Only those who have created or
selected price rate and have not already been charged in this or another bill.
Now i am just check for missing a service to create, we will click on record and we invoice
and the invoice created.

All we do in IdemHotel invoices can be exported to a file to import from IdemConta for
automatic posting (See section 5.6 .- Export Invoices to Accounting).

Update 2.3.2 .- Bill.

To modify an invoice, we can do from 3 sites:

1) Grid reserves
2) The reserve
3) List of bills

1) Grid reserves

a) Click on the button invoices in the bottom left button of the grid.
Select Search, the person concerned.
b) Click with the right mouse button on the reservation of the bill and select the billing option
- [Room ... and select the interested.

Once we have the bill in the display listing, we double-click it and will show the same screen
to create, only appear to the left on red background, indicating <| Edit ... :
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Now we can modify the bill as we are interested.

- The date of the invoice, the down payment, the payment ...
- We eliminate room reservations by clicking on the column, with the difference that appears.
This tells us that the record is deleted from this bill this reserve.
This is useful if we add another reservation / room who was not charged, in this case, the
deselect displayed in the column blank. While booking / room and billed to deselect Show

- Likewise, we can remove or add services. The column will follow the same approach as
before. Only services that we can also create, modify or delete a service directory

2.3.3 .- Delete Invoice.

You can delete an invoice in two different ways:
- One way is directly from the list of bills, making "click" on which you want to delete and
pressing the DELETE button.
- Another way is by selecting the Invoice to "double click, tab appears on the invoice and
pressing the button (CLEAR).

In both cases, IdemHotel asked for confirmation prior to deletion.

Only if the deleted invoice number series have prefix assigned Company IdemHotel gives us
the option to automatically bill counter the number of the bill eliminated.

2.3.4 .- Print / Send by e-mail an invoice.

To print a particular invoice, all you have to do is select by "double click" on it, and press the
button (PRINT) or (send by e_mail).

IdemHotel prints the hotel as Social Name, Product Name, tax number, full address, type
Hotel, Hotel Category, e_mail and Web.

Before leaving for printer IdemHotel gives us the opportunity to view the screen, selecting
this option.

If we selected Business Card Euro currency and the View in Pesetas, to print the invoice to
display the amount of each line and total in Euros and Pesetas.

We also have the following options when printing invoices.
- Paper size.
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Default size will be selected that option on the company tab (see section 1.1 .- Company).
For each bill we can select the paper size to print the invoice without having to go to
Enterprise, but only serve for the selected invoice.

- Pre-printed paper.
We print invoices preprinted. To do so select that option on the company tab (see section 1.1
.- Company).
For each bill we can select a pre-printed only if selected by the small size (1 / 2 A4).

- Print Prices.
IdemHotel gives us the option to print invoices so valued or worthless, as is checked Print
Prices or not.

Also according to invoice is and whom it is directed have different nuances.
- Print Invoice to company.
When printing bills of customers who are assigned a company will only enterprise data to the
customer.
For companies that have selected Size 1 / 2 A4 only the customer name of the company
under, but no customer data.

- Print Proforma Invoice.
Only if we print Proforma invoice we will be able to not print the hotel, printing only the
anagram.
It also gives us the possibility IdemHotel not print the details of the invoice, ie partial sums
will not print and print only the total amount.

3 .- TEXTS / mailing.

In this maintenance can create, modify and delete the letters. We use the 4D Write word
processor that includes IdemHotel. No need to exit the program and save text in the database
itself ..

We may also create mailing from here, using the same texts for different audiences, without
having to create a different text for each.

3.1 .- create a new text.

The first thing that should be indicated in order to create a new model is the title.

After entering the title, introduce the text in question, for which we can use word processing
tools.
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In the text we can put the logo of the company by "click" the button (logo), just in case we
have imported the image of the company's logo in the maintenance of Company (See Section
1.1 .- Company) . We can also print the text by "click" the button or using word processing.

Once the text has to do "click" on the REC button.

Both the title and dates served created and modified for use as search criteria, as explained
below.

Finally, selecting text and making clear that we want to "click" on the Clear button, the text
will be removed from the database.

3.2 .- A TEXT SEARCH.

To search in the database, a text that has previously been discharged, you must specify the
criteria by which IdemHotel want to search. To select a criterion, we first "click" on the box
of each item to display it, then you must specify desired:
- Title. First, mark it if we seek the criterion Title Begins ... or ... contains ... and enter the
title or part of it and press the Tab
- Date created. Mark the appropriate box and enter the date you create the text or texts that
interest us.
- Date modified. Mark the appropriate box and enter the date on which modify the text or
texts that interest us.

When finished enter any of these data, we must press the SEARCH button and a screen with
texts that meet these criteria. If you select no search criteria will display all text released. To
select the text you want, to do the "double click" on it.

Thereafter, IdemHotel display text and may proceed to your query or modification, if desired
by pressing the REC button and finally if you want to save changes the text in the database.

3.3 .- mailing

TEXTS maintenance we can use for making mailing, so we can print text with different
recipients without having to write one for each recipient.

On the screen where you enter the text will "click" with the right button mouse, displaying a
list of databases IdemHotel.
By placing the mouse on the desired database shows another list of fields that can be inserted,
which will select the one we are interested in making "click" on it.
For example, if the text need to put the names of customers select the database client process
and then we will "click" in the Name field from the displayed list, viewing.
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Using "click" on the button can display the names of the fields for the fields we have selected.
Selecting the field can change the attributes of the same as font, color, ....

Once we have the text in all fields to be integrated, select the Tools menu option to print the
following details ... viewing window.

This window lets you select the database from which we select the elements to integrate with
the text.
First select with a click the database from which we select items.
Then click the Search button ... and will indicate the search criteria in a search window that
displayed, press the Browse button.

For example, if we do a mailing cards to customers who were born in the month of October.
- First. Introduce the cards and insert text fields of the elements to be integrated, making
"click" in place that we want to insert with the right mouse button and then "click" on the
field that interests us from the displayed list.
 If the text need to put the names of customers select the database client process and then we
will "click" in the Name field from the displayed list, viewing.

- Second. We will "click" Print data ... from the Tools menu.
- Third. We "double click" on clients, and click the Search button ....
Indicate the search criteria Mes_Nacimiento by "click" on it and then from column
comparisons (right) select with a click the Equals option, and enter a "10" for the month of
October and will "click "Consultation on the button.

- Fourth. We will "click" on the Print button ....

Be printed as many texts as we have created in IdemHotel customers, who were born in
October, replacing the data input fields that are recorded in IdemHotel.

4 .- listings

Using "click" on the Done button from the General Menu, visualize this one menu where we
can make lists, invoices, in order to keep track of the hotel billing and receivables for other
dates.

In addition, as from the General Menu and Menu files, we can see the display screen of the
program, user manual and change connected with the corresponding buttons, as explained in
the section on General Menu.

4.1 .- LIST OF BILLS.
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Since this maintenance can view and print a list of bills made in IdemHotel ..

Using "click" the button BILLS LIST from the menu go into the maintenance files displaying
the next screen to locate the invoices that are interested.

We select the following criteria, also in combination:

- Invoice Date From - To. When all the bills indicates searching between those dates.
- Invoice number. To indicate the number will search the bill with this number.
- Client. Select client who owns the / s invoice / s we seek. To find the client can indicate
some characters of the name and / or ID card and locate customers IdemHotel match is
checked according starts ... or ... contains ...
- Agency. We can also find invoices belonging to agencies. Agencies will mark the option
and proceed as in customers to locate the agency.
- Invoice / Proforma. We choose to show us the Bills relationship only, only the Proforma
Invoice, or both, by checking the appropriate option.
In the list of invoices Proforma Invoices distinguish because they have a "P" before the
number.

Then you have to "click" on the SEARCH button displaying all invoices that meet the stated
criteria. This list so we can print by "clicking" on the PRINT button.

If you do not want to print all, with "click" on a bill while maintaining the key "CAPS" tight,
will be selected until the next bill that we "click" on it. If we select one at a time to do "click"
on the invoice and hold down while pressing the "CONTROL."

It also gives us the possibility IdemHotel to print or export the list of invoices with all
necessary information for the VAT tax. To print the relationship for the VAT tax will "click"
on the button (PRINT).
For example, for quarterly or annual payment of VAT will select the dates for the three
months to liquidate, all information printed on the VAT between the selected dates (Bases
VAT percentage share ,...)
Also can export a file out of the selection of bills IdemHotel with information relating to
VAT (VAT for each invoice, invoice Total ...). To do this we "click" on the button
(EXPORT).

From here you can select invoices by "double clicking" on them, and once selected can delete,
edit or print them, as well as from reserves (see section 2.3.-Bills)

4.2 .- clients listed by date

Listings with button CUSTOMER date may be printed or saved to a file out of IdemHotel, a
list of guests staying at the hotel between the dates prescribed by us, to have easy and fast this
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list whenever we need it, for authorities such as when we require information on guests
staying.

Indicate the dates that we want the list and "click" on the F8-PRINT button. The listing what
we see on screen before printing or print it directly with the appropriate options.
If you deselect the Include only new entry (Police) will include all stocks that have at least a
day set aside in the selected time interval. In the case of selecting this option will only include
stocks that match the entry with the selected date range.

4.3 .- customers for days listing

With the button DAILY LIST CLIENTS can print a list of guests staying at the hotel.

Dates indicate the days you want the list of guests occupying the room and we "click" on the
F8-PRINT button. The listing what we see on screen before printing or print it directly.

The list will contain the customers we have assigned a reservation / check into the hotel on
the days indicated and ordered each day for the room number. For example if you set the date
from 17/09 to 18/09 displayed first all customers who have reserved a room on 17/09 and
under all customers who have room on 18/09, ordered each day for the room number.

4.4 .- listing I.N.E. Statistics

With the LIST button I.N.E. Statistics We asked the start date statistics and thereafter
calculated and printed automatically most of the data we need to INE statistics

4.5 .- listing DINING

Dining with the LIST button. will tell us between the given dates and types of diet, list of
clients per room.

 4.6 .- Listing Service Chief

LIST button with the Service Chief. daily record of the status of the room, indicating whether
to change sheets, people in the room, children and cribs, as well as comments to the Chief
Customer Service.

 4.7 .- cash count

This option allows us to perform cash counts, per user, including dates, payment methods, ..

IdemHOTEL v.2012.0 Page 59 of 81



 
5 .- profits.

From the Utilities menu you can access the display screen of the program, user manual and
switch connected in the same way as in the General Menu.

In this we see the utility menu buttons: Control User Access, Backup both the program and
other data files, access to the License Agreement, Route Program, refer to the location of the
program and data we are using, checking invoices, Export Invoices Accounting Re-index
Data Files, Changing data file.
 
Here's how each one of the utilities mentioned above.

5.1.-BACKUP.

This is very important because it lets you copy all the information we have on the
management for possible failures before they can do to lose this information, it can recover.
Here are some of the most frequent cases that can cause data loss:
1 .- Faults external team as power outages.
2 .- Internal faults and equipment failures in the CPU, disks, etc.
3 .- Robbery, fire, etc.

For information to be retrieved when any of the above cases, we recommend the following: In
the first case, copy the information on any disk, the second event on a different disk copy of
the work and copy the third case removable disks (CD, optical disks ,....). You should choose
the appropriate combination depending on the level of security you want.

Single Client - Server, pressing the Backup button, located on the File menu, see the
following screen which will display the users logged Management.

Press Start backup, IdemHotel will enable us to delay for the start of the copy as during the
duration of this, users can not work. IdemHotel notify this to the connected users.

To back use the following window in which shall be selected data (since this is where they
keep all the information we have introduced IdemHotel and if information is lost for any
reason, could not be recovered). Also you can make backup copies of the program by
selecting the appropriate box and files, whether or not related to the management, selecting
the icon for files.
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You can select the number of different games you want to save the copy, recommending a
minimum of three games. The first copy will be made in the first game, the next in the second
and so on until the number of games that have been selected, from that copy, the following
will begin to do in the first game, erasing the game old and so on.

If you have tagged after the date of Company's option 4D Backup Backup Control, each time
we leave the program if we did not copy over a period of one day, we IdemHotel asked to do
the backup for us not forget make that copy.

5.2 .- CONTROL OF ACCESS.

From here you can modify access to the different processes of each of the groups that have
discharged.

When you enter this application, there is an area devoted to listing the various groups, another
area where the users of each group and the third area shows the list of all the access that the
user of each these groups.

When you select a group listing appears in the box on the right of the screen all the users that
belong to that group and the lower panel shows the list of all the processes to which they will
be allowed access.

To change any access, you must first select the User Group and then, within that group, then
becomes "click" on the Edit button. Finally, activate or deactivate the desired processes,
making "click" on the name of the process in question.

As a security measure, it is noted that selecting the group to try to modify IdemHotel (Group
who has access to all processes), IdemHotel displays a message saying it can not be changed.
Therefore, it is the only group that can not be changed and who has access to all processes.

5.3 .- LICENSE.

This maintenance is used to introduce or update the Serial Number of Product, the License
Code in the following cases:
- The case that we have installed the demo version and have acquired the license of Use
- The event to update the software version.
- The case recruit new Members.
You must enter codes Serial No. Product, the License Code, to be supplied IdemSoft, SL, for
that purpose and to "click" on the REC button.
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5.4 .- route program.

This button allows us to have located both the program IdemHotel same data as we are using.

When you "click" on the ROUTE button on the display program displays a window detailing
the location of the program where it says IdemHotel Programme and the information kept in
the database program, where it says Data.

5.5 .- check invoices.

This utility is useful to that of an electrical light failure, system failure, ... while we work on
IdemHotel, in the case of encountering discrepancies between invoices and billed services.
Using "click" the button checking invoices, IdemHotel will check all invoices, automatically
correcting the errors you find.

5.6 .- export invoices to accounting.

All we do in IdemHotel invoices can be exported to a file and then to import the file from
IdemConta (See manual IdemConta).

The export will:
1 - automatically create or modify IdemConta clients with tax data (name, ID number, ...)
billing.
2 .- Create the ledger accounts from customers, sales, ... .

(This export bills IdemHotel only be imported with the program IdemConta for automatic
posting, for more information about IdemConta please call 963 455 103 or through the Web
www.idemsoft.com)

Using "click" the button EXPORT BILLS TO ACCOUNTING bills we find that we are
interested to export. We select the following criteria, also in combination:
- Invoice Date From - To. When all the bills indicates searching between those dates.
- Invoice number. To indicate the number will search the bill with this number.
- Client. Select client who owns the / s invoice / s we seek. To find the client can indicate part
name and / or ID card and locate customers IdemHotel match is checked according starts ... or
... contains ...
- Agency. We can also find invoices belonging to agencies. Agencies will mark the option
and proceed as in customers to locate the agency.
- Assessed / Not Assessed. We choose to show us the relationship only Bills that SI have
been exported, only the bills that have NOT been exported or both by checking the
appropriate option.

Once identified, the bills have to select the invoices that wish to export.

IdemHOTEL v.2012.0 Page 62 of 81



If we want to select multiple bills at once we have two possibilities:
- Make "click" on a bill and then, holding the shift key down, to "click" on the other, all bills
being selected between the first and last selected invoice.
- Make "click" on a bill and then, holding the Control key ("Manzanita" in Macintosh) click
on the other bills that we want to select, one by one.

 Once you have selected will export invoices to do "click" the button EXPORT TO
ACCOUNTING, and indicate where we want to save the export. The bills then exported are
marked with an "E" in the column on the left of the screen located bills.

When there are bills that lacks any of the information necessary to account in IdemConta,
IdemHotel notified of this and cancel the export.

In the invoice screen located visualize the missing data to be exported to accounting:

 - IdemHotel marked with a "C" next to the Customer column ledger account is not assigned.
Do so in the column Agency.

- Mark with an "N" column next to the customers without VAT number. Do so in the column
Agency.

- Indicate if you need to indicate town, province or country the client or agency in the
appropriate column (Client Population, Population Agency).
 Population Column Client also marked with an "E" if the company assigned to the client that
is missing data.

5.7 .- reindex database

This utility should only be used under the supervision of the technical department IdemSoft,
SL To contact please call 963 455 103 or via email comercial@idemsoft.com

This utility will help us to correct problems or tables in the database, such as customers,
invoices, reservations, etc., For example due to a hard disk malfunction.

Using "click" the button RE-INDEX DATABASE IdemHotel shows a window from which to
select the table in the database that we re-index (customers, invoices, reservations, etc.)
Checking the appropriate option.
If we re-index all tables in the database will mark the option All database.

Finally we "click" on the Continue button.

5.8 .- TOOLBAR / DOCK.
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There is the possibility in WINDOWS (toolbar) and MacOS (Dock) for the user to define as
it has in the system. Thus respecting the application will open space in the event that this
asset, holding the toolbar (or dock in MacOS).

5.9 .- deleted from the database.

This option allows only demonstration version, delete all the information to start from scratch
our database.

5.10 .- modified data files.

Important note: This support is only available in the Standalone version of IdemHotel.

The data file is unique for the whole program IdemHotel (customers, reservations, invoices,
etc.). It stores all the information you input.

In this maintenance can

- Create a new data file.
- Open other IdemHotel data files that we created.
- Change the size of the database we are using, creating segments of the same data file.

5.10.1 .- create a new data file.

IdemHotel gives us the ability to create a new database without having to leave IdemHotel.

For example, if we open the data file for the example of IdemHotel (located in the folder
inside the folder example IdemHotel) and want to create a new data file to work from scratch
with our data.
To do so, follow these steps:

1 .- We will "click" the button DATA FILE MAINTENANCE.
2 .- We will "click" on the Create a new data file.
3 .- We will "click" in the F2-button CONTINUE.
4 .- will indicate the name of the new file IdemHotel (If you do not change the name will be
"IdemHotel") and then "click" on the Continue button, then follow the steps in IdemHotel.
The data file is created IdemHotel always with a ".4 DD".

Whenever we create a new data file IdemHotel, if we have introduced codes of the License
Agreement gives us the option to open the data file for the example of IdemHotel.
Select "NO" when what we want is to create a new data file.
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5.10.2 .- open a data file.

IdemHotel allows us to open an existing data file from IdemHotel.
For example it will be useful if you want to open the data file for the example of IdemHotel,
or if in the example to open the data file we will definitely use for our work.

To open the data file for the example:
1 .- We will "click" the button DATA FILE MAINTENANCE.
2 .- We will "click" on the Open a data file.
3 .- We will "click" in the F2-button CONTINUE.
4 .- We select with a click the data file we want to open, in this case "IdemHotel.4DD" and
will "click" on the Open button.

5.10.3 .- resizing a data file.

With this button we can change the size of data file IdemHotel we are using.
Very Important: Do not we use this option without consulting the technical department
IdemSoft, SL To contact please call (34) 963455103 or via email tec@idemsoft.com.

We can change the size of the database with the extension .4 DD, or add segments to the
database:

If we want to add a segment:
1 .- We will "click" on the ADD button.
2 .- We indicate in the File Name field the name of the segment and place in which you want
to save.
3 .- We will "click" on the Save button.
4 .- Once created, the segment will "click" Fit to define the size.
Suppose we want to save CD taxable external backups, so if you have 700 MB CD we adjust
both the first with extension .4 DD, to a maximum of 700000 bytes.
The total size of all segments (Max. 2 GB per segment) that we believe for the same database
can not exceed 132 GB
5 .- repeat the process for all the segments we want to add.

Important: Once you've created a new segment, when this has been used, we can not
eliminate it, because otherwise we could not reuse the data file, losing the information there.

Should be able to modify the technical department IdemSoft, SL tec@idemsoft.com.
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5.11 .- import customer data.

This support allows us to import from a text file of customer data. So that automatically
incorporate the database IdemHotel customers.

to facilitate the importation, has been left completely free format that must be on file. The
user only has to identify in this screen you want to import information as is in the file.
IdemHotel handles everything else.

 
6 .- SPREADSHEET.

6.1 .- CREATING A New worksheet.

Entering this maintenance, the first thing should be stated in order to create a new model is
the title, indicating the title of the spreadsheet will be created.

After entering the title, begin to work with the spreadsheet, for which we can use the same
tools.

We insert the logo of the company by "click" on the Insert button ANAGRAMA, only if we
have imported the image of the company's logo in the maintenance of company (Section 1.1).
We can also print the worksheet by "click" on the PRINT button or using the PRINT button
on the menu.

Once completed to do "click" on the REC button for data entered into the spreadsheet is
discharged into the database, assigning the date created. If that was not new but a selected,
record management will assign the date modified.
We can also save the spreadsheet in a file outside the management by using the SAVE button
in the menu on the worksheet. The standard format for storing spreadsheets is. "Slk".
 This file can then be used with other spreadsheets (Excel).

Selecting a worksheet you want to delete and making "click" on the CLEAR button, the
spreadsheet will be removed from management.

Both the title and dates served created and modified for use as search criteria, as explained
below.

6.2 .- FIND A spreadsheet.
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To search in the database, a spreadsheet that has previously been discharged, you must
specify the criteria by which management wants to search. To select a criterion, we first
"click" on the box of each item to display it, then you must specify desired:

- Title. First, mark it if we seek the criterion Title Begins ... or ... contains ... and enter the
title or part of it and press the Tab

- Date created. Mark the appropriate box and enter the date you created the worksheet that we
want.

- Date modified. Mark the appropriate box and enter the date on which modify the worksheet
that we want.

When finished enter any of these data, we must press the SEARCH button and a screen with
spreadsheets that meet those criteria. If you select no search criteria displays all spreadsheets
released. To select the worksheet you want, to do the "double click" on it.

Thereafter, management will show the spreadsheet and may proceed to your query or
modification, if desired by pressing the REC button and finally if you want to save changes to
the spreadsheet in the database.

6.3 .- matter fields.

Spreadsheets'll be able to integrate with data from the database management.
We import the same spreadsheet data we have on the management without having to enter
them manually, such as daily accounting data, addresses, number of customers and suppliers,
etc.

To add fields to the spreadsheet, for example the "name and address clients' we have created
in management:

1 .- We will "click" Database in the toolbar of the sheet and then Import Campos, displaying a
list of database management.
2 .- We select the database from the dropdown list, in this case "Customers."

3 .- To insert the fields you want to import, we will "click" to select the desired database, in
this case "clients" displaying another list of fields that can be inserted, which will select the
one we are interested in making "click 'on it. In this case we "click" on "Customer Name."
To insert another field will "click" on the New button and repeat the process to select in this
case "Customer Management."
 
4 .- Then press Search to find customers who want to import the information indicating the
search criteria and then clicking the Query button.
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5 .- Finally we "click" on the Import button.

The management of the name and address of the selected clients that are created in the
database.
7 .- sends information to DGGCIVIL / DGP / Mossos / Ertzaintza.

Since this maintenance, we send the report to parties, just select the day and you click the
Send button

Guardia Civil Case: If we put the data into File-> Business-> Guardia Civil, just click the
"Send" button, IdemHotel takes care of everything.
We ask you to confirm the location to save the history of files sent and automatically send the
information of the reports of travelers.

Police Case: We ask you to confirm the location to save the historic files sent and
automatically connect to the Web via Internet browser.
Once we identify the web of the police, we will enter the maintenance of sending data, locate
the file you've saved from IdemHotel and send it.

IMPORTANT: In both cases, the "Solo travelers NOT sent" should not uncheck it, unless
requests by the DGGCivil / DGP, since otherwise it will send guests have sent cards and we
will fail.

8 .- massive introduction of services.

Since this maintenance, we introduce bulk services, without having to go reserve reserves.

Therefore we should:

1) Insert the date of service.

IMPORTANT: When entering the date of service, IdemHotel to help you avoid mistakes in
Room will show only those that are occupied at that time.

2) Select the room.
3) Enter the service data.

In this way we can change the date of service and / or room and make all services from the
same screen.
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VIII .- CALCULATOR.

IdemHotel it includes a calculator to make it more convenient and faster calculations.

It is accessed from the small menu.

It can perform the basic operations needed, such as: addition, subtraction, multiplication, etc
...

Calculator performs the desired calculations while showing the results in euros and the
currency that is selected.

It can also perform calculations in any currency. By default it will in pesetas, but you can
select the currency you want, simply by "clicking" on the buttons with the flags of different
countries.

Also we will copy the value of the calculator by clicking "on that amount, then you can paste
it where we are interested in, press" Control V "if the operating system is Windows and"
Manzanita V "is Macintosh.

IX .- Modulo - INVENTORY -.

Since a module, it must be hired hand, but you can evaluate it, and that lets you enter up to 10
items in demo mode.

The inventory module will allow you to take control of both the situation of all fixed assets of
the hotel as: their physical condition, condition, repair, reports.
Allocated in each tab item that we believe have:

1 - Maintenance Reports, where you can reflect, per day, reports are made for each item.
2 - Maintenance Repair, where you can reflect, for each repair that is pointed to the article,
the cost of repair, the supplier who made the repair and report repair.
.
Like all IdemHotel maintenance, the access allows you to search or create a new article.

When searching, we show IdemHotel items found:

Besides power, as in the rest of the management, use of labels and reports profits and new
button to create a new article.
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They have a button that lets you know the valuation of items classified by hotel, type,
location, ..., for it will need to click "rating."

When entering a sheet article may reflect all the features, including a photograph.

As you can see the information about the article, may:
1) Sort items by item types, entering and creating maintenance deemed necessary.
2) Assign the provider
3) Give the location, here too we can create that need. In the case of a room by selecting the
room we show all the rooms are high and you can select the correct one.
4) State of the article, entering and creating maintenance deemed necessary.

Clicking on the Reports tab, you can see the article reports

Clicking on the Repair tab, you can see the repairs made to the article, including cost,
provider and report the repair.

This will allow them to take control and proper analysis of the situation of the articles of
hotel.

To access this information, we do also from File -> rooms.

When you enter a room that has reflected an item, the tab for the room will show the
information on the amount of goods that are in the same, and the amount of repairs made in it.
And if we want to see the details, so just click on the folder button with the eye and gain
access to all articles included in this room.
Being able to access both the item, such as the repair and maintenance reports.

X. - Modulo - UNIT
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Since a module, it must be hired hand, but you can evaluate if you know the connection
settings for your PBX, or by contacting our sales department for help.

The unit control module will allow you to have control of all calls made from his unit and
assigned automatically as a service, each call to book a room that matches the extension from
which the call was made, according to the prices fixed.
That is, no more forgetting to collect calls.

For this is the following means:

1 - Setting up the unit and price. From the main menu select File -> Company / Preferences.
In this screen you will click on the tab "Link phone"

From here you can:

1-1 Define and set the unit price and the form of connection.
On 1-2 and the process of connecting to the switchboard.
2 - Call Log. From the main menu select File -> Log. As its name suggests, here are recorded
all calls made from the exchange.
Both assigned to the rooms, such as those made from extensions assigned. Allowing us to
assign the call from any extension to a particular reservation.
The so-called "unallocated" are marked with an asterisk.

3 - Rooms. In the card room has added a new field "Extension telephone."
Here's the telephone extension assigned to the room. Thus any call made from it will
generate, automatically, a service to reserve the room.
To view the calls from that extension will click the button next to the field telephone.

4 - Billing. To avoid oversights in collecting called "unallocated", from the check we can see
the calls are not assigned by clicking the button, allowing you to assign at the time.

XI .- Modulo - PORTALS.

Since a module, it must be hired hand, but you can evaluate it, although she will update the
site but has hired him.

The Portals module will allow you to automatically update or manual occupation information
for those portals with which to reach agreements that allow us to automatically update the
information.
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The module can only work while maintaining an appropriate relationship portals with
Idemsoft, SL (IdemHotel) that allows us to interact with it.

We have reached agreements with my upgrade from IdemHotel Top Rural Bed and being the
most popular among our users.
Which add more content, just depends on which users ask us Idemsoft integration and to
reach agreements with their own portals for automatic updates, by any means intend.
IdemHotel technology can adapt to any requirement to interact with any of them.

To enter the Portals module from the General menu will click on web links.

From here, select My Bed or Top Rural.

Automatic system operation and / or manual with Mi Casa Rural / Top Rural.

This screen will show the parameter settings needed to connect to the portal.

This should complete the form with information you have provided Top Rural (ID Housing,
User Name and Password). Web and will automatically email the IdemHotel.
Upgrading to Top Rural is done through email, so it is very important not to change the email
that automatically follows, unless you change and / or notify Top Rural, otherwise the update
will not work.
If you mistakenly change the email, clicking on the button we can recover the original.
To send email, IdemHotel uses its own system, thus sending the message clear to the user.

IMPORTANT: You must have configured the email
File-> Company / Preferences -> email.

When upgrading IdemHotel sends two emails, one to Top Rural and another to the individual
user as proof of what has been sent.

Automatic Update:

To schedule automatic updates, we will click Update site and automatically mark. Now it just
remains to indicate every few hours IdemHotel want updated.
From time to save the changes. IdemHotel each "hours" that we have indicated send emails
automatically update with data from 12 months of the current count.
Only if you can not send email, it will show an alert to indicate that.

Updated Manual:

To manually update we will click the button below "Site Updates", which will show the
status of occupation of the current month.
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To upgrade, just have to click on the "Web Update."
Thus the month update provided on this window. We can change the month and year with the
top buttons and we will always update the month of the year shown on the screen.

If for any reason we would like to manually edit the graphic information shows IdemHotel,
we can right-click on the day we want to modify. We show a window with options to choose
from, We want it click and change to this shipment.
If we changed something in the month, will show a new button to undo your changes.
Clicking on it will leave the occupancy as it was before the changes.

 
XII .- Modulo - AGENDA / ALARMS

Since a module, it must be contracted separately.
But you can evaluate it for a period of time, that tells the program to start.

From the main menu we can access this module from the Date Book button / Alarms.
. By entering this maintenance, view the messages of the day.

Show the first line of text messages, time, type of message (Tel, Men., Vis ...), and the name
of the user who received the message.
Using "click" on any of them, you can enter the message and change what you like about it,
the text, date, time was created the message, add or remove and replace the alarm time and
date , etc. ..

Using "click" in Month or Year will have access to any month or year to create messages on
that date. We can also navigate with the arrow buttons attached to each case. Even if the year
is included in the calendar, we can go to him with the arrow

Also from here there is the possibility of travel to any day of the month in which we are,
simply by "clicking" on the desired day on the calendar

Using "click" in week view, opens a window that can display the entire week with the
messages that have each day.

If we had the need to enter one of those days to record any message or visit planned can be
done by "clicking" on Display messages that appear next to each day.

Finally, if one wants to see the messages that were sent to other users and have not answered,
it will take "click" the icon that appears below the user connected to the main screen and is
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composed of "two opposing sides' VIEW MESSAGES TO OTHER USERS. In the Business
Week also display this icon.

XII.1 .- Create a new message.

To create a new message, you must press the NEW button.

The user must select who you want to send the message. You can direct the message to the
same user, or ALL, OTHERS.

If OTHER is selected, users appear and you can select one or more.

The field of Forced Response, requires users of the message recipient to respond, and they
were not allowed to forget.

Alarm Box, with "click" on BELL ALARM the alarm being this way. We will post the date
and time you want to let us know. Add the usefulness of the buttons 1,2,3 ... 7, to
automatically indicate to let us know the number of days before the message.

On the other hand, by "clicking" ALARM BELL again deactivates the alarm is in this way.
After stating all of the above, proceed to write the appropriate text, not to mention saving the
REC button, once the writing.

XII.2 .- repetitive messages.

Do not repeat button allows us to create recurring alerts.
Clicking this button will display the options to set an alarm repeatedly.

We indicate the period: daily, biweekly, monthly or yearly and how often this period we
selected to repeat the warning.

So if we want to warn us daily is the example of the image, if we would change every 2 days
on 1 by 2 in each field. Similarly seleccionásemos act if any other of the periods.
Only if you are not always selected, we will indicate a date to repetitive alarm, next to and in
case you want to find the date in the calendar will click and double click on the desired date
for the put in this field.
The start date you want the alarm shown on the next date field
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To modify a repetitive message we can do by selecting the message and clicking the button
repetitive.

In the case of a repetitive message, and modify or delete, the application will show a window
to indicate whether the change affects only the day or all occurrences.

XII.3 .- ALARM.

The alarm is displayed when the user enters the application and identified.

From here you can print it, or remind us of the criteria that we offer (10 min., 30 min., 1 day,
exactly for days, hours or minutes).

Using "click" in the box Date / Time, another window appears where you state the date and
time you want to modify the alarm.
Also if it indicates the days, hours and minutes and is "click" the button ACCURATE,
postponing the alarm time has been indicated.

To reply to a message, you have to do "click" on the REPLY button (only active if another
user) and proceed to write the message.

You can also choose to disable the alarm with the Forget button. Forced Response if selected
in the message, the Forget button is not active and therefore can not be forgotten.

Alarms do to stop to do "click" in the ESC-STOP button viewing messages, automatically
leave the alarm and leaving the rest of Alarm display. After 10 minutes or to leave Agenda /
alarm will reactivate automatically.
XII.3 .- FIND A MESSAGE.

You can search for posts by a certain date, alarms or text, selecting appropriate search
criteria. First select the message type (All, visit, call, ...), but will always default ALL. Then
you can choose the date of the message or alarm, or both dates, which is to find the message.

You can also search by text stating the phrase or word to find and, IdemHotel seek texts that
contain them. If only the standard text is selected and nothing is written for search,
management display all messages. Using "click" on the desired message from the list of
wanted messages, IdemHotel enter the text of the

Message. From here you can change the text of the message, the date and the date of the
message alarm. After making the changes will have to keep with the REC button.
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Criteria can be selected that they want, even all three at once. Once selected the SEARCH
button is activated and will do "click" on it to display the selected messages.

XIII .- Modulo - INHOVA - ONITY

Since a module, it must be contracted separately.

First, we configure the module to act directly with the system or ONITY INHOVA card
generation doors.

Therefore we should go from IdemHOTEL settings and select the Keys tab.

 ONITY INHOVA or allow you to configure up to 8 different locations access control, apart
from the rooms.

With this, you can build idemHOTEL cards without fear of human error, and that makes it
automatically from the reserve.

To do this, go into the reserve, from which we generate the (s) card (s) where we have some
dedicated buttons:

To generate the card will click the first button

This will open the options window card generation.

We have the keys to generate new card or copy, in accordance with the above options.
In other rooms (only ONITY), we can select up to three rooms most of the current, where you
can access the card (eg loss. For parents who have children in other rooms)

In paragraph permits, they will come up 8 possible, depending on the configuration we have,
to give access to general entrance, swimming pool, ...
 

XIV .- Modulo - CHAR

Since a module, it must be contracted separately.
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This module is the module replacement unit.

With this, idemHOTEL makes a direct connection with the program CHAR, one of the best
targeted programs to control switchboards.
In this way we can have a larger control unit, to reflect part of the room calls, automatically
assigned as a reserve service. Thus not escape charge any call.

XV .- Modulo - QUOTA-

Since a module, it must be contracted separately.

This module allows us to reflect on the tab of the Agency, individual contracts for periods
quota of rooms.
In the statement the agency has added a new tab: Cupo. Clicking on it will show the current
contracts. If we want to see every click on the "View All."

From the grill and reserve have a new icon, by clicking on it will get the information from the
quotas.

From grating, clicking, shows the assignments per day / contract / agency to give information
on quotas, indicating the days before (or expiration quota), quota (No pop.) Type room,
reserved, pending reserve, ... .

From reservation, when clicked, shows the same information from grid, but only the agency
itself and also gives us the ability to select the quota for the reserve.

If you have selected a fit as indicated by the name of the agency in the area of the reservation.

XV .- Modulo - BDP-TPV

Since a module, it must be contracted separately.

This module allows automatic linking to program the house POS BDP.
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XVI .- Modulo - POS BAR / RESTAURANT -

Since a module, it must be contracted separately.

This module, developed by Idemsoft is a POS for bar and restaurant, built with the program,
so that we can generate tickets Restaurant for both cash, cards, ..., and assign it to a room as a
service. For safety, we can only assign the ticket to occupied rooms.

Integra maintenance for:

AREAS: Create the areas you need Barra, Hall 1, ...
FAMILIES: Create product families for quick product locaclización
PRODUCTS: Products classified by families. Where you can enter the price and photograph.

The POS Bar / Restaurant, is ready for normal operation with keyboard, mouse, and / or
touch screen.

Optimized printer EPSON TM-T88IV type role 8cm

You can work
1 .- In the same equipment used to manage the Hotel.

Click on the main menu button

Select Link POS-IdemTPVBar

From here select the button IdemTPV Bar

2 .- In multi mode, working as one team TPVBar, so that the show directly into the POS
screen.

Full Screen IdemTPVBar

The button allows us to block the POS for sure that no one can open drawer or handling. It is
a numeric code that can be defined, the default is 000.

In the top left will show the current date and time of the system.
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From buttons to date, we can select the date you want to see previous or future reserves
movements.

Under this button are areas we have created.

 We select the work area.

Once selected, show us the tickets or have reservations on that day and that area

If the icon is in color the dolls is that customers have come, if gray is not yet arrived.

With the button we can change the ticket or reservation.

The button lets you see the ticket and collected.

The button can create a new ticket or reservation

From this window, define the ticket

and clicking on the button we can define the reservation.

If it is for a room we can select.
For security reasons we only show rooms that are occupied.

On the right is the different families of products we have created and clicking on each family,
we show the products we have created.

To record consumption on the ticket you have two options

IdemHOTEL v.2012.0 Page 79 of 81



1) Select the product on the right and click the button

2) Select the product of the ticket list and click the same button.

In both cases, each time we click on that button will add one unit of the ticket.

If we reduce the amount of a product on the ticket, select the product on the ticket and we
will subtract button.

The same to clear a line of ticket, but the delete button.

With the button we can change the ticket line, text, quantity and price.

To open the drawer button utikizaremos

To print a ticket we will click on the button

We collect cash. We button

In this case you can specify the keyboard or clicking on the tickets and / or menedas the
amount paid by the customer. Indicating the change.
At the end we will click on the printer button to print the ticket.

We may charge by credit card. We button

Here we come a field to indicate the card number which has claimed.

We assign it to a room. We button

In this case we show the rooms that are occupied.
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By selecting the correct, automatically create the service in the reserve and print the ticket in
case you want to sign the client.

XVII .- Modulo - MAILING -

Since a module, it must be contracted separately.

This module allows personalized mass mailings to customers.

Once you select the mailing we click the send button again, from here we can select who we
want to send this mailing

With the buttons

Once defined we will click on the submit button.

From this screen you can compose your message.
Clicking the button will insert the text <- AAA_AAA -> where IdemHOTEL change if the
name correspodiente case in every shipment.

By submitting, keep a report of who has been sent and if there were errors when sending.
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